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KKaattaa  PPeennggaannttaarr  

IPB University dan CIFOR telah mengadakan pelatihan pertamanya 
yang bertajuk “The 1st Training Series of TRADE Hub Indonesia on 
stakeholder network analysis and kualitatif analysis” pada tanggal 7 
dan 14 November 2020. Seri Pelatihan TRADE Hub Indonesia 
bertujuan untuk mendukung upaya TRADE Hub untuk meningkatkan 
relevansi, mempromosikan pengaplikasian penelitian, dan 
mendukung pembuat keputusan di semua skala untuk 
mengembangkan dan menerapkan kebijakan dan peraturan yang 
relevan secara lebih efektif. Target peserta dari rangkaian pelatihan 
ini adalah para peneliti TRADE Hub di Indonesia tetapi juga peneliti 
muda di universitas dan institusi lainnya. TRADE Hub Indonesia 
Training Series akan memberikan platform pembelajaran bagi para 
pemangku kepentingan di Indonesia (misalnya, pembuat kebijakan, 
lembaga keuangan, dan sektor swasta), serta bagi mahasiswa, 
akademisi, peneliti muda, dan praktisi pada berbagai pengetahuan 
dan keterampilan untuk menciptakan produk penelitian yang kuat, 
proses pengambilan keputusan yang lebih baik, perumusan 
kebijakan, dan implementasi kebijakan sains yang efektif. 

Seri Pelatihan Pertama berfokus pada metodologi dan teknik 
penelitian berdasarkan kesadaran bahwa peneliti memiliki berbagai 
pengetahuan dan keterampilan penting untuk menciptakan produk 
penelitian yang kuat dalam topik pembangunan berkelanjutan yang 
kompleks, terutama di tengah pandemik. Materi dari pelatihan 
tersebut kemudian disusun menjadi sebuah buku untuk 
meningkatkan aksesibilitas terhadap knowledge product ini.  
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11.. PPeerrssiiaappaann  ddaann  IInnssttaallaassii  NNVViivvoo  ((TTrriiaall))  
NNVViivvoo1 adalah perangkat lunak berbasis komputer yang dikembangkan oleh QSR 
International, perusahaan developer yang berbasis di Melbourne, Australia sejak tahun 
2007. NVivo adalah salah satu perangkat lunak untuk analisis data kualitatif yang umum 
digunakan oleh akademisi di dunia. NVivo membantu para peneliti untuk menyusun, 
menganalisis dan menemukan poin penting dalam data kualitatif non-numerik dan tidak 
terstruktur seperti hasil wawancara, hasil survei dengan pertanyaan terbuka (open-
ended), artikel jurnal, media sosial dan konten website. Perangkat lunak ini berbayar 
melalui tarif lisensi tahunan atau lisensi abadi, serta harus di-install terlebih dahulu 
sebelum digunakan. NVivo menyediakan lisensi percobaan (trial) untuk meng-install 
dan mencoba secara gratis untuk 14 hari tanpa perlu mendaftarkan informasi 
pembayaran. Suatu alamat email hanya dapat digunakan dan didaftarkan untuk 
mendapatkan lisensi trial selama satu kali masa percobaan.  
Untuk meng-install NVivo, berikut adalah persyaratan minimum yang harus dimiliki 
komputer Anda: 

PPeerrssyyaarraattaann  mmiinniimmuumm  ssiisstteemm  PPeerrssyyaarraattaann  ssiisstteemm  yyaanngg  ddiirreekkoommeennddaassiikkaann  
• 2.0 GHz dual-core processor (64-

bit) 
• 4 GB RAM 
• 1680 x 1050 screen resolution 
• Microsoft Windows 8.1 
• Setidaknya terdapat minimum 5 

GB ruang penyimpanan yang 
tersedia pada harddisk Anda    

• 3.0 GHz quad-core processor  
• 8 GB RAM atau lebih 
• 1920 x 1080 screen resolution atau yang lebih 
• Microsoft Windows 8.1 atau versi yang lebih baru 
• Setidaknya terdapat minimum 8 GB ruang 

penyimpanan yang tersedia pada hard-disk Anda 
• Internet connection 
• Internet Explorer 11, Google Chrome 44 atau yang 

lebih baru 

 

Berikut adalah langkah-langkah untuk mempersiapkan perangkat lunak NVivo pada 
komputer Anda dengan lisensi trial. Dibutuhkan koneksi internet dan waktu yang cukup 
lama untuk download dan meng-install NVivo pada komputer Anda. Secara umum 
terdapat tiga langkah persiapan:  

 

 
 

1 https://www.qsrinternational.com/nvivo-qualitative-data-analysis-software/home 

Membuat akun 
myNVivo

Mengunduh 
perangkat lunak ke 

komputer Anda

Aktivasi lisensi trial
Anda
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11.. Buka tautan di bawah ini 
melalui penjelajah web Anda 
dan pilih “SSttaarrtt  TTrriiaall”” pada 
tautan berikut 

https://www.qsrinternational.com/nvivo-qualitative-data-analysis-software/try-
nvivo 

 

22.. Anda akan diarahkan untuk 
memilih versi percobaan 
perangkat lunak NVivo yang 
sesuai dengan sistem operasi 
yang Anda gunakan. Pilih 
““SSttaarrtt  TTrriiaall””  kemudian klik 
““CCoonnttiinnuuee”” pada pojok kanan 
pojok bawah 
 

 
 
 
 
 
 

33.. Pada “trial” harga lisensi 
bernilai 0 USD kemudian 
pilih ““CCoonnttiinnuuee””. 
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44.. Jika sudah memiliki akun NVivo, 
masukkan email Anda. Jika 
belum, silakan mendaftar 
dengan memilih opsi ““SSiiggnn  UUpp””. 

 

 

 

55.. Isikan data diri Anda yang 
diminta, centang pilihan privacy 
policy dan term and conditions. 
Kemudian klik ““SSiiggnn  UUpp””. 

 
 

 

66.. Email verifikasi akan dikirimkan 
kepada Anda dan lakukan 
verifikasi dengan klik tautan 
(verify email address) yang ada 
pada email, kemudian pilih “BBaacckk  
ttoo  LLoogg  IInn”. 
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77.. Anda akan diminta untuk 
mengisikan kembali data saat log 
in Anda (email dan password).  

 

 

 

88.. Setelah itu, Anda akan berada 
pada halaman home akun 
MyNVivo Anda. Klik “DDoowwnnllooaadd”. 

 

 

 

99.. Anda akan diarahkan kembali 
untuk memilih versi percobaan 
perangkat lunak NVivo yang 
sesuai dengan sistem operasi 
yang Anda gunakan. Pilih ““SSttaarrtt  
TTrriiaall””  kemudian klik ““CCoonnttiinnuuee”” 
pada pojok kanan pojok bawah. 

 

1100.. Setelah itu, Anda akan diminta 
untuk memasukkan data 
mengenai institusi Anda, sektor 
(akademik atau non-akademik), 
dan negara. Kemudian pilih 
““CCoonnffiirrmm  TTrriiaall””. 
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1111.. Setelah itu, unduh NVivo sesuai 
dengan sistem operasi yang Anda 
gunakan. 

 
 
 
 
 

1122.. Setelah berhasil diunduh, installer 
akan berada di bagian bawah browser 
Anda atau di folder download pada 
komputer Anda. ““OOppeenn  ffiillee  iinnssttaalllleerr”” 
NVivo yang telah Anda unduh pada komputer Anda,  

 

1133.. Klik “YYeess””  (Dialog box ini tidak selalu 
muncul, namun kemungkinan akan 
muncul jika Anda menggunakan 
sistem windows), lalu pilih bahasa 
yang akan Anda gunakan lalu klik 
“OOKK”. Dialog box lainnya akan 
muncul yang menyatakan bahwa 
pengaturan untuk install sedang 
disiapkan.  

 
 

1144.. Dalam proses instalasi, NVivo akan 
merujuk perangkat lunak lain yang perlu 
di-install, klik ““IInnssttaallll””. Perangkat lunak 
yang perlu di-install akan berbeda-beda 
tergantung dengan yang dimiliki 
komputer Anda. 

 

 
77  

 

1155.. Jika persyaratan pada 
komputer Anda sudah 
terpenuhi, Anda akan siap 
meng-install NVivo. Klik 
“NNeexxtt”. 

 

 
 

 
 

1166..  Silakan untuk membaca license 
agreement jika dibutuhkan, klik ““II  
aacccceepptt  tthhee  tteerrmmss  iinn  tthhee  lliicceennssee  
aaggrreeeemmeenntt””, lalu klik ““NNeexxtt””. 

 

 

 

 

1177.. Setelah itu, dialog box akan 
memberikan informasi pada folder 
mana file perangkat lunak akan 
disimpan. Klik ““NNeexxtt””. 
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1188.. Dialog box akan memberikan informasi 
add-ons (perangkat tambahan pada 
perangkat yang sudah ter-install 
sebelumnya) apa yang dapat di-install 
bersama, yaitu NCapture untuk 
browser Anda. NCapture akan 
bermanfaat untuk mengunduh big 
data dari website misalnya dari search 
engine google, yahoo, dll. Centang 
NCapture dan klik ““NNeexxtt””. 

 

1199.. Setelah itu, dialog box akan 
menginformasikan bahwa perangkat 
lunak siap di-install. 

 

 

 

 

2200.. Dialog box akan menginformasikan 
bahwa proses instalasi sedang 
berjalan. Silakan tunggu sampai proses 
selesai, biasanya akan memakan waktu 
5-10 menit.  
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2211.. Jika proses selesai, dialog box akan 
menginformasikan bahwa instalasi 
telah dilakukan dengan lengkap. 
Centang ““LLaauunncchh  NNVViivvoo”” dan Klik 
““FFiinniisshh””. Silakan tunggu sampai NVivo 
terbuka. 

 

 

2222..  Ketika NVivo berhasil dibuka 
pertama kali, klik ““LLoogg  iinnttoo  
mmyyNNVViivvoo””. Setelah itu 
masukkan email dan password 
akun myNVivo Anda, lalu klik 
““LLoogg  iinn””. 
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““OOKK””. 
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1188.. Dialog box akan memberikan informasi 
add-ons (perangkat tambahan pada 
perangkat yang sudah ter-install 
sebelumnya) apa yang dapat di-install 
bersama, yaitu NCapture untuk 
browser Anda. NCapture akan 
bermanfaat untuk mengunduh big 
data dari website misalnya dari search 
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NCapture dan klik ““NNeexxtt””. 
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2244.. Anda akan diarahkan untuk 
mengisikan profil akun 
pengguna Anda. Isikan nama 
dan inisial pengguna untuk 
Anda pakai dan pilih bahasa 
yang akan digunakan 
(direkomendasikan English). 
Centang ““PPaarrttiicciippaattee  iinn  tthhee  
CCuussttoommeerr  EExxppeerriieennccee  
IImmpprroovveemmeenntt  PPrrooggrraamm”” jika 
Anda bersedia berpartisipasi 
dalam survei pelanggan 
NVivo, tidak perlu centang jika Anda tidak bersedia. Klik ““OOKK””. 

 

2255.. NVivo versi trial (percobaan) 
siap digunakan untuk 14 hari 
ke depan setelah Anda 
melakukan instalasi. 

 

 

22.. AAlluurr  kkeerrjjaa  aannaalliissiiss  ddaattaa  kkuuaalliittaattiiff  
Riset kualitatif adalah proses yang berulang (iterative process) dalam 
mengeksplorasi dan menganalisis data (Gambar 1). Proses ini dimulai dengan 
mengimpor data, kemudian mengeksplorasi data untuk mengamati apakah ada 
pola yang muncul (emerging) atau berulang (recurring) dari data tersebut. Proses 
ini dilanjutkan dengan coding yakni melabeli dan mengorganisir data untuk 
mengidentifikasi tema (theme) dan hubungan (relationship). Proses coding dapat 
dimulai secara deduktif maupun induktif, di mana proses deduktif adalah 
membangun buku kode (codebook) atau panduan dalam melakukan coding 
sebelum analisis dimulai (Table 1). Untuk riset eksploratif, codebook bisa dibuat 
berdasarkan data, yang disebut dengan proses induktif (Yi 2018). Langkah 
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selanjutnya adalah merefleksikan data dan hasil coding, kemudian 
memvisualisasikan data.  

 
Gambar 1 Alur kerja analisis data kualitatif, diadaptasi dari QSR International 

Tabel 1 Contoh codebook 

CCooddee  DDeesskkrriippssii  CCoonnttoohh  
IIssii  ddeennggaann  
jjeenniiss  ccooddee..  
CCoonnttoohh::  
““ddeeffiinniissii””  

Isi dengan deskripsi untuk 
menjelaskan code yang dimaksud 
pada kolom pertama. 
Misalnya: 
Responden atau teks merujuk pada 
bagaimana konsep restorasi 
gambut diartikan maupun 
dikonseptualisasikan. Definisi ini 
dapat memuat aspek sosial maupun 
ekologis dari restorasi, misalnya 
kondisi hidrologi dan vegetasi.  

Isi dengan contoh data yang 
menunjukkan mengapa data 
tersebut masuk dalam kategori 
code (kolom pertama). 
CCoonnttoohh::  
Restorasi adalah mengembalikan 
ekosistem sesuai dengan kondisi 
sebelum rusak. Kami tahu, kami 
tidak pernah akan bisa mencapai 
kondisi tersebut, tapi paling tidak 
kami sudah mencoba. 

33.. SSeekkiillaass  mmeennggeennaaii  NNVViivvoo  
NVivo adalah sebuah perangkat lunak (software) berbayar untuk menganalisis data 
kualitatif. NVivo memungkinkan untuk tim (maksimal lima orang) bekerja bersama 
dalam menganalisis data melalui fitur Collaboration Cloud2. Perangkat lunak ini 
memungkinkan para peneliti maupun praktisi dalam menganalisis data secara efektif 
dan efisien. Data maupun hasil analisis dapat divisualisasikan dalam word cloud, tree 

 
 

2 https://www.qsrinternational.com/nvivo-qualitative-data-analysis-software/about/nvivo/modules/ 
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map, dan lain-lain. Lisensi NVivo dapat dibeli secara individu ataupun secara kolektif 
melalui institusi. Pusat pembelajaran NVivo dapat diakses disini3. 

44.. PPeerrssiiaappaann  ddaattaa44    
Persiapkan data yang ingin dianalisis dalam satu folder. Beberapa data yang dapat 
diproses oleh NVivo dapat berupa: 

• DDookkuummeenn  ddaann  mmeemmoo  
Dokumen dan memo ini bisa berupa transkripsi hasil wawancara, catatan 
lapangan, jurnal artikel, laporan, dan lainnya dalam bentuk file Microsoft Word 
(.doc, .docx), Rich Text Files (.rtf), Text Files (.txt), maupun Portable Document 
Format (.PDF). 

• SSeett  ddaattaa  ((ddaattaasseett))  
Dataset ini merupakan data terstruktur yang diatur berdasarkan baris (row) 
dan kolom (column). Dataset ini dapat berupa data hasil survei dalam bentuk 
spreadsheet (.xls, .xlsx) maupun metadata dari data media sosial yang 
dikumpulkan melalui NCapture.5 

• MMuullttiimmeeddiiaa  
NVivo juga dapat digunakan untuk mengimpor multimedia, misalnya audio, 
video, dan gambar, yang diperoleh dari diskusi kelompok terfokus (Focus 
Group Discussion – FGD), observasi, dan lain-lain. Beberapa format yang 
kompatibel dengan NVivo adalah: MOV, MP4, AVI, M4A, MP3, WAV, .gif, .jpeg, 
.png, dan .tiff. 

• BBiibblliiooggrraaffii  
Jika Anda telah melakukan kajian literatur dengan menggunakan EndNote X7, 
maka Anda dapat mengimpor data dari aplikasi tersebut dalam bentuk file 
EndNote (XML) dan mengimpor ke perangkat lunak NVivo. 

  

 
 

3 https://www.qsrinternational.com/nvivo-qualitative-data-analysis-software/resources/ 
4 https://help-nv.qsrinternational.com/20/mac/Content/files/files.htm  
5 NCapture adalah ekstensi dari NVivo yang tersedia di penjelajah web Google Chrome. Ekstensi ini digunakan untuk 
mengekstrak data dari sosial media 
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55.. MMuullaaii  mmeenngggguunnaakkaann  NNVViivvoo  
55..11.. MMeemmbbuuaatt  pprrooyyeekk  bbaarruu  ((nneeww  pprroojjeecctt))  aattaauu  mmeemmbbuukkaa  pprrooyyeekk  tteerrbbaarruu  ((rreecceenntt  

pprroojjeecctt))  

Buka perangkat lunak 
NVivo kemudian pilih 
““CCrreeaattee  NNeeww  PPrroojjeecctt”” 
untuk membuat proyek 
baru atau pilih ““RReecceenntt  
PPrroojjeeccttss”” untuk membuka 
proyek terbaru yang telah 
dikerjakan (Gambar 2). 
Pada laman ini 
ditunjukkan pula akses ke 
pusat pembelajaran 
(learning center) dan 
sumber daya pendukung 
(support resources). 

Saat Anda memilih proyek baru, maka NVivo akan mengarahkan Anda pada laman baru 
(Gambar 3) untuk memberi nama pada proyek Anda. Anda juga akan diminta untuk 
memiliki lokasi penyimpanan file ini. Kemudian pilih ““NNeexxtt” lalu “CCrreeaattee  pprroojjeecctt””..    

 

Gambar 2 Laman utama NVivo untuk membuka proyek baru atau 
membuka proyek terbaru 

Gambar 3 Beri nama dan tentukan lokasi penyimpanan file 
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Jika Anda ingin membuka file NVivo (.nvpx ataupun .nvp, 
Gambar 4) yang telah Anda simpan, klik dua kali pada file 
tersebut dan NVivo otomatis akan membuka file tersebut. 

 

 

55..22.. MMeennggiimmppoorr  ddaattaa  

Setelah proyek baru 
berhasil dibuat, Anda 
akan diarahkan pada 
laman utama NVivo. 
Untuk mulai 
mengimpor data, pilih 
““IImmppoorrtt”” kemudian 
pilih jenis file yang akan 
diimpor (Gambar 5). 
Kemudian dialog box 
file explorer akan 
muncul. Pilih file yang 
dikehendaki, dapat 
memilih lebih dari satu, kemudian pilih ““OOppeenn””  lalu pada dialog box selanjutnya klik 
““IImmppoorrtt”” (Gambar 6). Pada modul ini akan mempelajari data wawancara (dalam bentuk 
.doc) dan literatur (dalam bentuk PDF). Dokumen dapat diunduh di ttaauuttaann  iinnii6 

 

 

 
 

6 https://ipb.link/tradehub-nvivo 

Gambar 6 Pilih file yang akan dianalisis, 
kemudian pilih “Open” lalu “Import” 

Gambar 4 File NVivo 
akan tersimpan dalam 
ekstensi .nvpx atau .nvp 

Gambar 5 Impor data dengan memilih tab “Import”, kemudian pilih “Files” 
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55..33.. MMeennggoorrggaanniissiirr  ddaattaa  

Data yang telah diimpor dapat diorganisir berdasarkan kasus (“CCaassee  CCllaassssiiffiiccaattiioonn””) atau 
(“FFiillee  CCllaassssiiffiiccaattiioonn”): Fitur ini dapat ditemukan pada menu “HHoommee””  (Gambar 7). Jika 
diorganisir berdasarkan kasus, maka kasus ini merepresentasi unit observasi. Misalnya 
sebuah proyek penelitian dapat memuat kasus untuk orang, lokasi, organisasi, atau 
entitas. Pengorganisasian data berdasarkan kasus (“CCaassee”) ditunjukkan pada Gambar 8, 
misal ada satu responden bernama “Ken” yang terlibat dalam wawancara, survei, dan 
diskusi kelompok, maka dapat dibuat satu ““CCaassee”” khusus dengan nama “Ken”.  

 

  
Gambar 7 Opsi pengorganisasian data berdasarkan kasus (“Case Classification”) atau file (“File 

Classification”) 
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Gambar 8 Organisasi data berdasarkan kasus atau “Case” 

Sumber: QSR International 

Pada modul ini akan membahas cara mengorganisasi data dengan ““FFiillee  CCllaassssiiffiiccaattiioonn””..  
Cara mengorganisasi data dengan menggunakan opsi ini dilakukan untuk 
mengelompokkan dokumen berdasarkan jenis ekstensi dokumen tersebut sebagai 
contoh wawancara dan literatur. Pilih ““FFiillee  CCllaassssiiffiiccaattiioonn””  pada menu HHoommee, kemudian 
klik  ““NNeeww  FFiillee  CCllaassssiiffiiccaattiioonn””. Setelah itu, isi informasi pada dialog box dengan memberi 
nama kelas klasifikasi yang diinginkan lalu klik ““OOKK””. Ulangi langkah ini ketika Anda 
membuat kelas klasifikasi baru. Dalam modul ini akan dibuat dua kelas klasifikasi yaitu 
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““wwaawwaannccaarraa”” dan ““lliitteerraattuurr””,,  oleh karena itu langkah ini diulangi sebanyak dua kali 
(Gambar 9). 

 

 
Gambar 9 Klasifikasi file dengan menggunakan fitur “File Classification” 

 

Kemudian, kembali ke ““FFiilleess”” yang ada di tab sebelah kiri dan mulai kategorikan file. Klik 
kanan pada file tersebut dan pilih ““CCllaassssiiffiiccaattiioonn”” kemudian pilih ““wwaawwaannccaarraa”” atau 
““lliitteerraattuurr””  (Gambar 10). Pilihan warna ada di klik kanan lalu ““CCoolloorr””. Hasil kelas 
klasifikasi yang telah dibuat terdapat pada menu “File Classifications” di menu kiri 
(Gambar 11) 
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Gambar 8 Organisasi data berdasarkan kasus atau “Case” 

Sumber: QSR International 
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klik  ““NNeeww  FFiillee  CCllaassssiiffiiccaattiioonn””. Setelah itu, isi informasi pada dialog box dengan memberi 
nama kelas klasifikasi yang diinginkan lalu klik ““OOKK””. Ulangi langkah ini ketika Anda 
membuat kelas klasifikasi baru. Dalam modul ini akan dibuat dua kelas klasifikasi yaitu 
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““wwaawwaannccaarraa”” dan ““lliitteerraattuurr””,,  oleh karena itu langkah ini diulangi sebanyak dua kali 
(Gambar 9). 

 

 
Gambar 9 Klasifikasi file dengan menggunakan fitur “File Classification” 

 

Kemudian, kembali ke ““FFiilleess”” yang ada di tab sebelah kiri dan mulai kategorikan file. Klik 
kanan pada file tersebut dan pilih ““CCllaassssiiffiiccaattiioonn”” kemudian pilih ““wwaawwaannccaarraa”” atau 
““lliitteerraattuurr””  (Gambar 10). Pilihan warna ada di klik kanan lalu ““CCoolloorr””. Hasil kelas 
klasifikasi yang telah dibuat terdapat pada menu “File Classifications” di menu kiri 
(Gambar 11) 
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Gambar 10 Klasifikasi file pada kategori yang telah dibuat 

 
Gambar 11 Hasil klasifikasi file (Files classifications -> klik kelas klasifikasi -

> akan muncul daftar file dalam kategori tersebut 

 

55..44.. CCooddiinngg  

5.4.1. Membuat codes 

Buka file yang telah diklasifikasikan dalam ““wwaawwaannccaarraa””  melalui FFiilleess dan klik file, 
kemudian baca secara menyeluruh. Setelah itu, tentukan codes apa yang akan dibuat 
dari data tersebut. Untuk membuat codes baru, highlight bagian dari teks yang akan di-
coding. Kemudian klik kanan dan pilih opsi ““CCooddee  SSeelleeccttiioonn””  setelah itu akan muncul 
dialog box untuk membuat code baru. Klik “CCrreeaattee  NNeeww  TToopp--LLeevveell  CCooddee””, lalu setelah 
muncul ganti nama new code tersebut. Setelah itu klik “CCooddee  SSeelleeccttiioonn  ttoo  NNeeww  CCooddee”” 
(Gambar 12). Bisa juga memilih opsi ““CCooddee””  pada menu bar atas agar lebih cepat, klik 
““CCooddee  SSeelleeccttiioonn””. 
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Gambar 12 Melabeli data pada code 

Setelah membuat ““CCooddeess”” baru, Anda dapat mengisi ““CCooddee  PPrrooppeerrttiieess”” yang memuat 
spesifikasi nama, deskripsi, dan warna. Klik ““CCooddeess””  pada menu di pojok kiri, klik kanan 
pada code yang sudah dibuat kemudian klik ““CCooddeess  pprrooppeerrttiieess””..  Setelah itu, dialog box 
akan muncul untuk diisi. Anda dapat memberi warna codes. (Gambar 13). 
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Gambar 13 Pengisian “Code Properties” 

5.4.2. Parent dan child codes 

Anda dapat pula membuat “child codes”. Parent codes adalah klasifikasi yang lebih 
umum, sementara child codes adalah klasifikasi yang lebih spesifik, misalnya sebagai 
berikut: 

Restorasi → Parent codes 
• Revegetasi → Child codes 
• Rewetting → Child codes 
• Revitalisasi → Child codes 

 

 
2211  

Untuk membuat parent dan 
child codes ini, pilih tab 
““CCooddeess”” dan kemudian pilih 
parent code yang telah 
dibuat. Klik kanan dan pilih 
““NNeeww  CCooddeess””, maka NVivo 
akan otomatis membuat child 
code dengan memunculkan 
dialog box yang perlu diisi. Isi 
dialog box tersebut dengan 
nama dan warna. Anda bisa cek apakah benar itu child codes dengan melihat box 
hierarchical name. Parent 
codes akan disebut dahulu 
sebelum child codes. Lalu klik 
“OK” (Gambar 14). 

 

 

 

 

 

5.4.3. Membedakan data yang sudah di-coding 

Untuk membedakan bagian mana yang sudah di-coding Anda dapat memilih fitur 
““HHiigghhlliigghhtt”” dan atau ““CCooddiinngg  SSttrriippeess””. Fitur  ““HHiigghhlliigghhtt”” akan menyoroti teks yang sudah 
di-coding. Sementara fitur ““CCooddiinngg  SSttrriippeess”” akan menunjukkan jenis-jenis code (Gambar 
15). Untuk memudahkan proses analisis, aktifkan kedua fitur ini dengan memilih 
““HHiigghhlliigghhtt””  kemudian ““AAllll  CCooddiinngg”” dan ““CCooddiinngg  SSttrriippeess”” kemudian pilih ““AAllll””. 

Gambar 14 Membuat child codes 
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Gambar 14 Membuat child codes 
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Gambar 15 Tampilan dari teks yang sudah disoroti dengan fitur “Highlight” dan “Coding Stripes” 

5.4.4. Uncode 

Fitur ““CCooddiinngg  SSttrriippeess”” juga memudahkan dalam uncode atau menghapus codes dari 
bagian teks tertentu. Untuk melakukan ini, klik kanan pada codes, kemudian pilih 
““UUnnccooddee””  (Gambar 16). 
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Gambar 16 Gunakan fitur “Coding Stripes” untuk melakukan uncode 

5.4.5. Mengekspor codebook dari hasil coding 

Codes yang telah dibuat dengan menggunakan NVivo dapat diubah dan diekspor 
menjadi codebook (.docx). Proses ini dapat dilakukan dengan memilik tab ““SShhaarree”” 
kemudian pilih opsi ““EExxppoorrtt”” dan ““EExxppoorrtt  CCooddeebbooookk”” (Gambar 17). 

 
Gambar 17 Mengekspor codebook dari hasil coding di NVivo 

NVivo akan menghasilkan satu file baru dalam format Microsoft Word (.docx) yang 
berisikan nama codes, deskripsi, file, dan referensi (Gambar 18). 
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Gambar 15 Tampilan dari teks yang sudah disoroti dengan fitur “Highlight” dan “Coding Stripes” 

5.4.4. Uncode 

Fitur ““CCooddiinngg  SSttrriippeess”” juga memudahkan dalam uncode atau menghapus codes dari 
bagian teks tertentu. Untuk melakukan ini, klik kanan pada codes, kemudian pilih 
““UUnnccooddee””  (Gambar 16). 
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Gambar 16 Gunakan fitur “Coding Stripes” untuk melakukan uncode 

5.4.5. Mengekspor codebook dari hasil coding 
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kemudian pilih opsi ““EExxppoorrtt”” dan ““EExxppoorrtt  CCooddeebbooookk”” (Gambar 17). 
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berisikan nama codes, deskripsi, file, dan referensi (Gambar 18). 
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Gambar 18 Contoh codebook yang dihasilkan dari coding NVivo 

55..55.. VViissuuaalliissaassii  ddaattaa  

Visualisasi data dalam NVivo dapat membantu memahami tema yang muncul 
(emerging) dan berulang (recurring) secara cepat pada tahap awal analisis. Selain itu, 
visualisasi data ini juga membantu dalam proses refleksi dan presentasi. Ada berbagai 
macam visualisasi yang dapat dilakukan di NVivo baik secara otomatis maupun manual 
(misalnya menggambar peta konsep). Modul ini akan membahas visualisasi yang 
dihasilkan secara otomatis dari NVivo. Silakan tutup file sebelumnya lalu buka file 
Visualisasi Windows.nvp untuk mempelajari fitur visualisasi (Gambar 19). 

 
Gambar 19 Silakan untuk menutup file sebelumnya dan membuka file Visualisasi Windows yang telah 

disediakan 
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5.5.1. Bagan hierarki 

Bagan hierarki memvisualisasikan pengelompokan codes dan digunakan untuk melihat 
proporsi tema satu dengan yang lainnya dalam data. Pilih ““EExxpplloorree”” kemudian 
““HHiieerraarrcchhyy  CChhaarrtt””. Kemudian dialog box akan muncul, klik “AAmmoouunntt  ooff  ccooddiinngg  ffoorr  ––  
ccooddeess””  lalu “NNeexxtt””,,  setelah itu “CCoommppaarree  ––  AAllll  ccooddeess” dan “CCooddeedd  ttoo  ––  AAllll  ffiilleess,,  eexxtteerrnnaallss  
&&  mmeemmooss” lalu “FFiinniisshh” (Gambar 20) 

 

 
Gambar 20 Langkah-langkah memunculkan hierarchical chart untuk visualisasi 

Setelah bagan ditampilkan Anda dapat memilih visualisasi ““TTrreeeemmaapp”” (Gambar 21) 
ataupun ““SSuunnbbuurrsstt”” (treemap dalam bentuk radial, Gambar 22). 
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Gambar 21 Visualisasi bagan hirarki dalam bentuk treemap 

 
Gambar 22 Visualisasi bagan hirarki dalam bentuk sunburst 

 

5.5.2. Frekuensi kata 

Word cloud memvisualisasikan kata yang paling sering muncul (most frequent words) 
pada codes, files, maupun cases. Word cloud ideal untuk tahap awal penelitian, 
khususnya pada penelitian eksploratif, untuk melihat pola yang muncul ataupun 
berulang secara cepat. Pada tab ““EExxpplloorree”” pilih ““WWoorrdd  FFrreeqquueennccyy””..  Lalu pilih jumlah 
display words dan minimum length yang diinginkan, setelah itu pada bagian grouping 
pilih “wwiitthh  sstteemmmmeedd  wwoorrddss””. Untuk membuat word cloud dari hasil coding, pilih 
““SSeelleecctteedd  IItteemmss”” lalu dialog box akan muncul (Gambar 23). 

 

 
2277  

 
Gambar 23 Langkah-langkah visualisasi word cloud 

Pada dialog box, centang “AAuuttoommaattiiccaallllyy  sseelleecctt  ssuubbffoollddeerrss”” dan “AAuuttoommaattiiccaallllyy  sseelleecctt  
ddeesscceennddaanntt  ccooddeess””. Kemudian centang codes dan pilih codes yang diinginkan untuk 
ditampilkan. Setelah itu pilih OK (Gambar 24). 

 
Gambar 24 Langkah-langkah visualisasi word cloud (2) 

Ketika sudah kembali ke laman NVivo, lalu klik ““RRuunn  QQuueerryy”” dan NVivo akan 
menampilkan ringkasan ((““SSuummmmaarryy””) beserta dengan ““WWoorrdd  CClloouudd”” (Gambar 25).  
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Gambar 21 Visualisasi bagan hirarki dalam bentuk treemap 
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Ketika sudah kembali ke laman NVivo, lalu klik ““RRuunn  QQuueerryy”” dan NVivo akan 
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Gambar 25 Langkah-langkah visualisasi word cloud (3) 

Bila ada kata-kata yang tidak penting, seperti “yang”, “ini”, “itu”, masuk dalam word 
cloud Anda, maka pilih ““SSuummmmaarryy”” kemudian klik kanan pada kata tersebut. Setelah itu, 
pilih ““AAdddd  ttoo  SSttoopp  WWoorrdd  LLiisstt”” agar NVivo tidak lagi mengikutsertakan kata tersebut 
dalam word cloud maupun daftar kata teratas Anda. Pilih ““RRuunn  QQuueerryy”” lagi untuk 
menampilkan word cloud final (Gambar 26). 

 
Gambar 26 Langkah-langkah visualisasi word cloud (4) 

Anda dapat mengganti tampilan word cloud dengan memilih setting yang ada pada 
bagian atas setelah Anda membuka menu WWoorrlldd  FFrreeqquueennccyy  QQuueerryy (Gambar 27). 
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Gambar 27 Visualisasi kata yang paling sering muncul melalui word cloud 

5.5.3. Pencarian kata 

Visualisasi pencarian kata digambarkan melalui pohon kata atau word tree. Jenis 
visualisasi ini menunjukkan bagaimana kata-kata tertentu atau terpilih dan konteks di 
mana kata tersebut digunakan dalam wawancara ataupun literatur. Untuk visualisasi 
ini, pilih ““TTeexxtt  SSeeaarrcchh”” kemudian pilih ““SSeelleecctteedd  IItteemmss””  dan tentukan apakah ingin 
melihat konteks pada codes, files, ataupun cases. Kemudian masukkan kata 
““kkeebbaakkaarraann”” dan pilih ““SSppeecciiaall”” di bagian kanan. Lalu, pilih ““AANNDD”” dan masukkan kata 
““ggaammbbuutt””. Setelah itu pilih ““IInncclluuddee  SStteemmmmeedd  WWoorrddss””  kemudian ““RRuunn  QQuueerryy”” (Gambar 
28 dan 29).  

 
Gambar 28 Langkah-langkah menggunakan text search query 
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Gambar 25 Langkah-langkah visualisasi word cloud (3) 
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menampilkan word cloud final (Gambar 26). 
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Gambar 27 Visualisasi kata yang paling sering muncul melalui word cloud 

5.5.3. Pencarian kata 

Visualisasi pencarian kata digambarkan melalui pohon kata atau word tree. Jenis 
visualisasi ini menunjukkan bagaimana kata-kata tertentu atau terpilih dan konteks di 
mana kata tersebut digunakan dalam wawancara ataupun literatur. Untuk visualisasi 
ini, pilih ““TTeexxtt  SSeeaarrcchh”” kemudian pilih ““SSeelleecctteedd  IItteemmss””  dan tentukan apakah ingin 
melihat konteks pada codes, files, ataupun cases. Kemudian masukkan kata 
““kkeebbaakkaarraann”” dan pilih ““SSppeecciiaall”” di bagian kanan. Lalu, pilih ““AANNDD”” dan masukkan kata 
““ggaammbbuutt””. Setelah itu pilih ““IInncclluuddee  SStteemmmmeedd  WWoorrddss””  kemudian ““RRuunn  QQuueerryy”” (Gambar 
28 dan 29).  

 
Gambar 28 Langkah-langkah menggunakan text search query 
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Gambar 29 Langkah-langkah menggunakan text search query (2) 

Untuk memunculkan word tree, tutup tab “Text search criteria”, lalu klik tab pada 
“Word tree” pada pojok kanan bawah (Gambar 30) 

 
Gambar 30 Visualisasi kata gambut dan kebakaran beserta konteksnya dalam word tree 

 

5.5.4. Diagram 

Diagram memvisualisasikan perbandingan antar codes, files, maupun cases. Pada tab 
““EExxpplloorree”” pilih ““DDiiaaggrraamm”” kemudian pilih ““CCoommppaarree  CCooddeess””, setelah itu pilih codes 
yang akan dibandingkan. Misalnya, untuk ““aaccttiivviittyy”” dan ““cchhaalllleennggee””, kemudian pilih 
OOKK  (Gambar 31) 

 

 
3311  

 
Gambar 31 Langkah-langkah memunculkan comparison diagram 

Untuk memunculkan comparison diagram, centang “cchhiillddrreenn”” pada menu bagian atas 
setelah tab CCoommppaarriissoonn  DDiiaaggrraamm terbuka (Gambar 32). 

 
Gambar 32 Visualisasi diagram perbandingan antar codes 
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Gambar 29 Langkah-langkah menggunakan text search query (2) 

Untuk memunculkan word tree, tutup tab “Text search criteria”, lalu klik tab pada 
“Word tree” pada pojok kanan bawah (Gambar 30) 

 
Gambar 30 Visualisasi kata gambut dan kebakaran beserta konteksnya dalam word tree 

 

5.5.4. Diagram 

Diagram memvisualisasikan perbandingan antar codes, files, maupun cases. Pada tab 
““EExxpplloorree”” pilih ““DDiiaaggrraamm”” kemudian pilih ““CCoommppaarree  CCooddeess””, setelah itu pilih codes 
yang akan dibandingkan. Misalnya, untuk ““aaccttiivviittyy”” dan ““cchhaalllleennggee””, kemudian pilih 
OOKK  (Gambar 31) 
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Gambar 31 Langkah-langkah memunculkan comparison diagram 

Untuk memunculkan comparison diagram, centang “cchhiillddrreenn”” pada menu bagian atas 
setelah tab CCoommppaarriissoonn  DDiiaaggrraamm terbuka (Gambar 32). 

 
Gambar 32 Visualisasi diagram perbandingan antar codes 
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66.. NNCCaappttuurree  
NCapture adalah ekstensi browser web gratis untuk Chrome yang memungkinkan Anda 
mengumpulkan konten web untuk diimpor ke NVivo. (Dukungan untuk NCapture untuk 
Internet Explorer dihentikan pada tahun 2020, namun Anda masih dapat menginstal 
versi terakhir jika diperlukan). Sebagian besar halaman web dapat ditangkap sebagai 
PDF. Anda juga dapat menangkap beberapa halaman dari Facebook, Twitter, dan 
YouTube sebagai kumpulan data, video, dan gambar. File NCapture (.nvcx) berisi konten 
yang Anda ambil serta URL, waktu pengambilan, dan informasi tambahan apa pun 
seperti deskripsi, memo, dan pengkodean yang Anda tentukan pada saat pengambilan. 
Beberapa tangkapan dari situs media sosial menghasilkan banyak file setelah diimpor 
ke NVivo. Misalnya, konten Facebook dapat berisi kumpulan data NVivo serta gambar. 
Lihat data media sosial Saat mengambil dari Facebook atau Twitter untuk pertama 
kalinya, Anda harus meng-otorisasi NCapture. Otorisasi NCapture Bergantung pada 
versi NVivo Anda, beberapa jenis konten yang diambil tidak dapat diimpor ke proyek 
Anda.  

 

66..11.. MMeenngg--iinnssttaallll  NNccaappttuurree  ddii  CChhrroommee  

Jika Anda telah menginstal NVivo, NCapture mungkin telah diinstal di komputer Anda 
sebagai bagian dari instalasi NVivo. Jika tidak, Anda dapat menginstalnya secara manual. 
Anda memerlukan Chrome 44 (atau lebih baru) untuk menggunakan NCapture untuk 
Chrome. 

1. Buka NCapture untuk 
Chrome di Toko Web 
Chrome. 

2. Klik tombol Tambahkan ke 
Chrome dan konfirmasi di 
kotak dialog. NCapture 
untuk Chrome 
ditambahkan ke Chrome, 
dengan ikon di bilah alat. 

Anda tidak perlu menginstal NVivo untuk menggunakan NCapture. Misalnya, Anda 
dapat meminta asisten peneliti yang tidak memiliki NVivo untuk menginstal NCapture 
dan mengumpulkan Tweet. Mereka dapat mengirim file NCapture (.nvcx) kepada Anda 
untuk diimpor ke proyek NVivo Anda. 
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66..22.. MMeennaannggkkaapp  kkoonntteenn  ddeennggaann  NNCCaappttuurree  

Anda dapat mengimpor konten media sosial dari Facebook, Twitter dan YouTube yang 
telah Anda kumpulkan dengan NCapture. 

1. Di browser Anda, buka konten yang ingin Anda tangkap. 
2. Klik tombol NCapture di bagian atas browser Anda. 

 
 

 

 

 

 

 

 

 

3. Pilih jenis hasil dokumen. Tergantung pada jenis konten yang Anda lihat, 
Anda mungkin akan melihat opsi pengambilan yang berbeda.  

4. Tinjau dan ubah nama file. 
5. Anda dapat memasukkan deskripsi singkat atau memo: 

a. Deskripsi menjadi salah satu properti file dalam NVivo. 
b. Memo yang Anda masukkan menjadi memo tertaut saat file 

diimpor. 
6. Secara opsional, masukkan satu atau beberapa kode (“node” di versi NVivo 

sebelumnya) untuk mengkodekan konten. Saat Anda mengimpor konten ke 
NVivo, seluruh file dikodekan ke ini. 

a. Jika Anda memasukkan kode yang tidak ada di proyek Anda—atau 
salah ketik namanya—kode baru akan dibuat. 

b. Jika mengkode ke kode yang ada, masukkan nama kode hierarki—
misalnya, “trade”\”sawit”. 

7. Klik “Capture”. Konten yang diambil disimpan sebagai file NCapture (.nvcx) 
yang dapat Anda impor ke proyek NVivo Anda 
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66..33.. OOttoorriissaassii  AAkkuunn  MMeeddiiaa  SSoossiiaall  ((TTwwiitttteerr))  

Kumpulan data dibuat berisi Tweet yang telah Anda rekam. Setiap hyperlink dalam 
Tweet akan dicatat. Jika Tweet menyertakan tautan ke file media, file media tidak 
diimpor ke proyek Anda, tetapi Anda dapat mengaksesnya dari hyperlink. 

Jika Tweet adalah hasil pencarian di Twitter, Anda dapat meng-klik tautan di kolom 
Istilah Pencarian di kumpulan data untuk melakukan pencarian baru di Twitter. 

Secara default, informasi pengguna seperti jenis kelamin atau lokasi akan diimpor 
bersama dengan Tweet. Jika ini tidak relevan dengan penelitian Anda, Anda dapat 
mengubah perilaku ini di properti proyek. 

Sebelum mendapatkan data, akun harus diotorisasi dahulu. 

 

77.. BBaahhaann  BBaaccaaaann  
Yi, E. 2018. Themes don”t just emerge – coding the qualitative data. Diakses dari: 
https://medium.com/@projectux/themes-dont-just-emerge-coding-the-qualitative-
data-95aff874fdce  (11 November 2020) 

QSR International. NVivo for Mac getting started guide. Diakses dari: 
http://download.qsrinternational.com/Document/NVivo11forMac/11.1.0/NVivo-for-
Mac-Getting-Started-Guide.pdf  (11 November 2020) 

Jackson, K., & Bazeley, P. (2019). Qualitative data analysis with NVivo. Sage. 
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11.. TTuuttoorriiaall  RReeggiissttrraassii  AAkkuunn  KKUUMMUU  
KUMU (https://www.kumu.io/) adalah perangkat lunak berbasis website yang dibuat 
oleh Jeff dan Ryan Mohr di Amerika Serikat pada tahun 2011. KUMU dapat digunakan 
untuk visualisasi stakeholder mapping, systems mapping, social network mapping, 
community asset mapping, dan concept mapping. KUMU menawarkan keunggulan 
dalam memberikan pengguna untuk menghadirkan visualisasi yang menarik untuk data 
yang kompleks serta dapat juga untuk membuat database visual. KUMU juga memiliki 
beberapa fitur analisis otomatis misalnya untuk perhitungan metrik dalam analisis 
jaringan sosial, deteksi komunitas, dan klasterisasi. Selain itu, KUMU memiliki fitur 
untuk membuat presentasi online yang memudahkan Anda untuk membagikan hasil 
penelitian Anda. Pada dasarnya, KUMU adalah platform gratis, namun data Anda akan 
tersedia untuk publik. Jika data Anda ingin tersedia secara pribadi, Anda dapat memilih 
layanan berbayar. 

Berikut adalah langkah-langkah registrasi akun KUMU: 

11..11.. RReeggiissttrraassii  KKUUMMUU    

11.. Buka website KUMU 
melalui browser Anda 
https://www.kumu.io/  
 

22.. Masuk pada menu “JJOOIINN  
FFOORR  FFRREEEE” yang berada di 
pojok kanan atas.  

 
 

33.. Isikan data-data yang dibutuhkan untuk registrasi. Halaman registrasi ini juga 
dapat diakses langsung di tautan berikut  https://www.kumu.io/register  
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FFiirrsstt  aanndd  llaasstt  nnaammee 
Nama depan dan nama belakang, contoh: 
Miftah Rahman 

EEmmaaiill  aaddddrreessss 
Alamat email Anda, contoh: 
miftahrahman@email.com 

CChhoooossee  aa  uusseerrnnaammee 
Pilih nama user yang akan Anda gunakan, 
bisa menggunakan angka 0-9 dan/atau 
huruf a-z serta tanda hubung (-). Contoh 
username misalnya miftahrahman, 
miftahr20, miftah_rahman 

CChhoooossee  aa  ppaasssswwoorrdd 
Masukan kata sandi yang akan Anda 
gunakan, kata sandi ini selanjutnya akan 
digunakan setiap kali proses masuk ke 
dalam akun Anda di website KUMU. 

Jika Anda ingin menerima newsletter bulanan dari KUMU, Anda bisa centang "Yes, I”d 
like to receive Kumu”s monthly newsletter". Anda tidak perlu mencentangnya jika tidak 
ingin menerima newsletter bulanan dari KUMU. 

Setelah semua data diisikan, klik "I”m not robot" untuk verifikasi dan "Create your 
account" untuk memproses pembuatan akun Anda. 

44.. Akun Anda telah berhasil dibuat jika halaman DASHBOARD berikut ini muncul. 
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55.. Silakan pelajari fitur KUMU lebih lanjut di Learn the essentials 
https://docs.kumu.io/  

66.. Buka website KUMU melalui browser Anda https://www.kumu.io/ dan klik menu 
SIGN IN. 

 

 
 

77.. Pada halaman SIGN IN, isikan data username atau email dan password yang telah 
Anda registrasi sebelumnya lalu klik "Sign in". 

 

88.. Setelah sign in berhasil, Anda akan terhubung ke halaman DASHBOARD akun 
KUMU Anda. 
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22.. IInntteerrpprreettaassii  ddaattaa  ddaassaarr  ddaann  ppeerrssiiaappaann  uunnttuukk  aannaalliissiiss  jjaarriinnggaann  ssoossiiaall  
ddeennggaann  KKUUMMUU  

1. Buka file excel TRADE Hub_7Nov20_Data KUMU_A dan file TRADE 
Hub_7Nov20_Templat KUMU dapat diunduh di sini 
 

2. File excel TRADE Hub_7Nov20_Data KUMU_A berisi matriks data hasil survei 
jaringan sosial kepada aktor-aktor yang telah diidentifikasi memiliki peranan 
dalam tata kelola komoditas A. Data dalam bentuk adjacency matrix. 

 

Gambar 1 Cara interpretasi data hasil survei (Adjacency matrix) 

Kolom A adalah daftar aktor sebagai subject/sender dan kolom pada baris 1 adalah 
daftar aktor sebagai object/receiver (lihat Gambar 1). Angka 1 bermakna aktor 
yang menjadi subject/sender menyatakan bahwa ada interaksi mengenai tata 
kelola komoditas dengan aktor yang menjadi object/receiver, sedangkan angka 0 
bermakna tidak ada interaksi.  

Contoh: Data pada kolom C2 bermakna pemerintah pusat menyatakan memiliki 
interaksi langsung dengan pemerintah daerah dalam tata kelola komoditas A dan 
data pada kolom D2 bermakna bahwa pemerintah pusat menyatakan tidak 
memiliki interaksi langsung dengan petani. 

3. Data hasil survei akan dianalisis dengan KUMU, oleh karena itu dilakukan 
penyesuaian ke format templat KUMU (File TRADE Hub_7Nov20_Template 
KUMU). Templat KUMU berisi dua sheet, sheet pertama untuk pemasukan 
data elements (Gambar 2) dan data kedua untuk data connections (Gambar 3). 
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Gambar 2 Sheet pertama templat KUMU (elements data) 

 
Gambar 3 Sheet kedua templat KUMU (connections data)  

33.. PPeennggiissiiaann  sshheeeett  eelleemmeennttss  
Element dalam KUMU adalah aktor/stakeholder yang menjadi fokus analisis, dapat 
berupa individu atau organisasi. Sheet ini berisi daftar aktor/stakeholder yang 
merupakan data dasar. Jika dibutuhkan, dapat ditambahkan data detail yang dapat 
memperkaya analisis atau visualisasi dari element tersebut pada kolom 
selanjutnya seperti type, description, tags, organization, dll. Dalam KUMU, atribut 
element disebut field. 

Isi sheet element dengan daftar aktor sesuai dengan data. Contoh pada Gambar 4 
berikut adalah pengisian untuk komoditas A. Untuk mempersingkat nama dapat 
juga digunakan ID.  
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22.. IInntteerrpprreettaassii  ddaattaa  ddaassaarr  ddaann  ppeerrssiiaappaann  uunnttuukk  aannaalliissiiss  jjaarriinnggaann  ssoossiiaall  
ddeennggaann  KKUUMMUU  

1. Buka file excel TRADE Hub_7Nov20_Data KUMU_A dan file TRADE 
Hub_7Nov20_Templat KUMU dapat diunduh di sini 
 

2. File excel TRADE Hub_7Nov20_Data KUMU_A berisi matriks data hasil survei 
jaringan sosial kepada aktor-aktor yang telah diidentifikasi memiliki peranan 
dalam tata kelola komoditas A. Data dalam bentuk adjacency matrix. 

 

Gambar 1 Cara interpretasi data hasil survei (Adjacency matrix) 

Kolom A adalah daftar aktor sebagai subject/sender dan kolom pada baris 1 adalah 
daftar aktor sebagai object/receiver (lihat Gambar 1). Angka 1 bermakna aktor 
yang menjadi subject/sender menyatakan bahwa ada interaksi mengenai tata 
kelola komoditas dengan aktor yang menjadi object/receiver, sedangkan angka 0 
bermakna tidak ada interaksi.  

Contoh: Data pada kolom C2 bermakna pemerintah pusat menyatakan memiliki 
interaksi langsung dengan pemerintah daerah dalam tata kelola komoditas A dan 
data pada kolom D2 bermakna bahwa pemerintah pusat menyatakan tidak 
memiliki interaksi langsung dengan petani. 

3. Data hasil survei akan dianalisis dengan KUMU, oleh karena itu dilakukan 
penyesuaian ke format templat KUMU (File TRADE Hub_7Nov20_Template 
KUMU). Templat KUMU berisi dua sheet, sheet pertama untuk pemasukan 
data elements (Gambar 2) dan data kedua untuk data connections (Gambar 3). 
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Gambar 2 Sheet pertama templat KUMU (elements data) 

 
Gambar 3 Sheet kedua templat KUMU (connections data)  

33.. PPeennggiissiiaann  sshheeeett  eelleemmeennttss  
Element dalam KUMU adalah aktor/stakeholder yang menjadi fokus analisis, dapat 
berupa individu atau organisasi. Sheet ini berisi daftar aktor/stakeholder yang 
merupakan data dasar. Jika dibutuhkan, dapat ditambahkan data detail yang dapat 
memperkaya analisis atau visualisasi dari element tersebut pada kolom 
selanjutnya seperti type, description, tags, organization, dll. Dalam KUMU, atribut 
element disebut field. 

Isi sheet element dengan daftar aktor sesuai dengan data. Contoh pada Gambar 4 
berikut adalah pengisian untuk komoditas A. Untuk mempersingkat nama dapat 
juga digunakan ID.  
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Gambar 4 Pengisian sheet elements pada templat KUMU 

44.. PPeennggiissiiaann  sshheeeett  ccoonnnneeccttiioonnss  
Connections dalam KUMU adalah hubungan interaksi antar aktor/stakeholder 
yang menjadi fokus analisis. Sheet ini berisi data jaringan sosial dalam bentuk 
edgelist matrix. Data survei adalah dalam bentuk adjacency matrix, oleh karena 
itu perlu diubah dalam bentuk edgelist matrix. Silakan lihat Kotak Tips 2 untuk cara 
cepat mengubah bentuk matriks dengan menggunakan web-based matrix 
expander. 

KKoottaakk  TTiippss  11::  CCaattaattaann  ppeennttiinngg  ddaallaamm  ppeennggiissiiaann  sshheeeett  eelleemmeennttss  

• Label merupakan informasi dasar untuk analisis dengan KUMU, harus diisi selalu 
dan berada pada kolom pertama (kolom A pada excel). Label merupakan nama 
aktor/stakeholder yang akan ditampilkan pada peta visualisasi KUMU.  

• Field seperti label, type dll harus selalu ada di row pertama. 
• Tidak boleh ada jeda kolom maupun row kosong. 
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KKoottaakk  TTiippss  22::  DDuuaa  ccaarraa  cceeppaatt  uunnttuukk  kkoonnvveerrssii  aaddjjaacceennccyy  mmaattrriixx  mmeennjjaaddii  
eeddggeelliisstt  mmaattrriixx::  

11..  MMeellaalluuii  wweebbssiittee  hhttttppss::////mmaattrriixx--eexxppaannddeerr..nneettlliiffyy..aapppp//    

a) Siapkan adjacency matrix dalam file excel seperti contoh di bawah berikut. Nama 
aktor/stakeholder/element/label tidak boleh mengandung spasi dan pastikan posisi data berada 
mulai pada row paling atas dan kolom paling atas. 

  
  

bb)) Buka website hhttttppss::////mmaattrriixx--eexxppaannddeerr..nneettlliiffyy..aapppp//  

  

c) Klik start atau drag kursor ke bawah, lalu unggah excel dengan meng-klik upload matrix. Kotak 
upload akan berubah hijau jika file Anda sudah berhasil diunggah. 
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Gambar 4 Pengisian sheet elements pada templat KUMU 

44.. PPeennggiissiiaann  sshheeeett  ccoonnnneeccttiioonnss  
Connections dalam KUMU adalah hubungan interaksi antar aktor/stakeholder 
yang menjadi fokus analisis. Sheet ini berisi data jaringan sosial dalam bentuk 
edgelist matrix. Data survei adalah dalam bentuk adjacency matrix, oleh karena 
itu perlu diubah dalam bentuk edgelist matrix. Silakan lihat Kotak Tips 2 untuk cara 
cepat mengubah bentuk matriks dengan menggunakan web-based matrix 
expander. 

KKoottaakk  TTiippss  11::  CCaattaattaann  ppeennttiinngg  ddaallaamm  ppeennggiissiiaann  sshheeeett  eelleemmeennttss  

• Label merupakan informasi dasar untuk analisis dengan KUMU, harus diisi selalu 
dan berada pada kolom pertama (kolom A pada excel). Label merupakan nama 
aktor/stakeholder yang akan ditampilkan pada peta visualisasi KUMU.  

• Field seperti label, type dll harus selalu ada di row pertama. 
• Tidak boleh ada jeda kolom maupun row kosong. 

 

 
4433  

 

KKoottaakk  TTiippss  22::  DDuuaa  ccaarraa  cceeppaatt  uunnttuukk  kkoonnvveerrssii  aaddjjaacceennccyy  mmaattrriixx  mmeennjjaaddii  
eeddggeelliisstt  mmaattrriixx::  

11..  MMeellaalluuii  wweebbssiittee  hhttttppss::////mmaattrriixx--eexxppaannddeerr..nneettlliiffyy..aapppp//    

a) Siapkan adjacency matrix dalam file excel seperti contoh di bawah berikut. Nama 
aktor/stakeholder/element/label tidak boleh mengandung spasi dan pastikan posisi data berada 
mulai pada row paling atas dan kolom paling atas. 

  
  

bb)) Buka website hhttttppss::////mmaattrriixx--eexxppaannddeerr..nneettlliiffyy..aapppp//  

  

c) Klik start atau drag kursor ke bawah, lalu unggah excel dengan meng-klik upload matrix. Kotak 
upload akan berubah hijau jika file Anda sudah berhasil diunggah. 
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d) Pilih “directed” untuk matrix connections 

 

e) Klik “Expand” 

 

f) Drag ke bawah dan unduh file hasil, misalnya dalam format Excel. 

 

g) Salin sheet berisi matriks hasil konversi ke sheet connections pada Excel untuk KUMU 
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Gambar 5 Pengisian sheet connections pada templat KUMU 

Gambar 5 adalah contoh pengisian sheet connections untuk templat KUMU. Pada 
dasarnya, sheet ini berisi daftar semua data hubungan/interaksi antar 
aktor/stakeholder. Data pada kolom A di bawah judul "From" adalah subject/sender, 
dan data pada kolom B di bawah judul "To" adalah object/receiver. Strength biasanya 
adalah nilai dari sociometric choices yang biasanya menunjukkan ukuran seberapa 
spesifik hubungan antar aktor/stakeholder. Data sociometric choices biasanya diperoleh 
pada saat survei melalui pertanyaan rating atau ranking. Jika dibutuhkan, dapat 
ditambahkan data detail yang dapat memperkaya analisis atau visualisasi dari 
connection tersebut pada kolom selanjutnya seperti type, description, tags dan lainnya. 
Atribut dari connection juga disebut field dalam fitur KUMU. 

 

KKoottaakk  TTiippss  33::  CCaattaattaann  ppeennttiinngg  ddaallaamm  ppeennggiissiiaann  sshheeeett  ccoonnnneeccttiioonnss  

• Connections (From dan To) merupakan informasi dasar untuk analisis 
dengan KUMU, harus diisi selalu dan berada pada dua kolom pertama 
(kolom A dan B pada Excel).  

• Judul field seperti label, type dll harus selalu ada di baris pertama. 
• Tidak boleh ada jeda kolom maupun baris kosong. 
• Setelah Excel files untuk KUMU yang berisi data elements dan 

connections telah siap, maka data bisa dianalisis dengan KUMU. 
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d) Pilih “directed” untuk matrix connections 

 

e) Klik “Expand” 

 

f) Drag ke bawah dan unduh file hasil, misalnya dalam format Excel. 

 

g) Salin sheet berisi matriks hasil konversi ke sheet connections pada Excel untuk KUMU 
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Gambar 5 Pengisian sheet connections pada templat KUMU 

Gambar 5 adalah contoh pengisian sheet connections untuk templat KUMU. Pada 
dasarnya, sheet ini berisi daftar semua data hubungan/interaksi antar 
aktor/stakeholder. Data pada kolom A di bawah judul "From" adalah subject/sender, 
dan data pada kolom B di bawah judul "To" adalah object/receiver. Strength biasanya 
adalah nilai dari sociometric choices yang biasanya menunjukkan ukuran seberapa 
spesifik hubungan antar aktor/stakeholder. Data sociometric choices biasanya diperoleh 
pada saat survei melalui pertanyaan rating atau ranking. Jika dibutuhkan, dapat 
ditambahkan data detail yang dapat memperkaya analisis atau visualisasi dari 
connection tersebut pada kolom selanjutnya seperti type, description, tags dan lainnya. 
Atribut dari connection juga disebut field dalam fitur KUMU. 

 

KKoottaakk  TTiippss  33::  CCaattaattaann  ppeennttiinngg  ddaallaamm  ppeennggiissiiaann  sshheeeett  ccoonnnneeccttiioonnss  

• Connections (From dan To) merupakan informasi dasar untuk analisis 
dengan KUMU, harus diisi selalu dan berada pada dua kolom pertama 
(kolom A dan B pada Excel).  

• Judul field seperti label, type dll harus selalu ada di baris pertama. 
• Tidak boleh ada jeda kolom maupun baris kosong. 
• Setelah Excel files untuk KUMU yang berisi data elements dan 

connections telah siap, maka data bisa dianalisis dengan KUMU. 
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55.. AAnnaalliissiiss  DDaattaa  JJaarriinnggaann  SSoossiiaall  ddeennggaann  KKUUMMUU  ((mmeellaalluuii  iimmppoorrtt  ffiillee  
EExxcceell))  

55..11.. MMaassuukk  kkee  ddaallaamm  aakkuunn  KKUUMMUU  

1. Buka website KUMU melalui browser Anda https://www.kumu.io/ dan klik 
menu "SIGN IN". 

 
Gambar 6 Tampilan home website KUMU 

2. Pada halaman ini, isikan data username atau email dan password yang 
telah Anda registrasi sebelumnya lalu klik "Sign in". 

 

Gambar 7 Halaman login pada website KUMU 
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55..22.. MMeemmbbuuaatt  nneeww  pprroojjeecctt  ppaaddaa  KKUUMMUU  

11.. Setelah sign in berhasil, Anda akan terhubung ke halaman "DASHBOARD" akun 
KUMU Anda, lalu klik "NEW PROJECT". 

 
Gambar 8 Halaman dashboard pada KUMU 

 

22.. Isi informasi project, terutama project name. Pilih public pada pemilihan 
pricing plan.  

 
Gambar 9 Halaman new project pada website KUMU 
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55.. AAnnaalliissiiss  DDaattaa  JJaarriinnggaann  SSoossiiaall  ddeennggaann  KKUUMMUU  ((mmeellaalluuii  iimmppoorrtt  ffiillee  
EExxcceell))  

55..11.. MMaassuukk  kkee  ddaallaamm  aakkuunn  KKUUMMUU  

1. Buka website KUMU melalui browser Anda https://www.kumu.io/ dan klik 
menu "SIGN IN". 

 
Gambar 6 Tampilan home website KUMU 

2. Pada halaman ini, isikan data username atau email dan password yang 
telah Anda registrasi sebelumnya lalu klik "Sign in". 

 

Gambar 7 Halaman login pada website KUMU 
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55..22.. MMeemmbbuuaatt  nneeww  pprroojjeecctt  ppaaddaa  KKUUMMUU  

11.. Setelah sign in berhasil, Anda akan terhubung ke halaman "DASHBOARD" akun 
KUMU Anda, lalu klik "NEW PROJECT". 

 
Gambar 8 Halaman dashboard pada KUMU 

 

22.. Isi informasi project, terutama project name. Pilih public pada pemilihan 
pricing plan.  

 
Gambar 9 Halaman new project pada website KUMU 
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33.. Jika Anda memilih untuk layanan tanpa biaya, data Anda dapat diakses publik. 
Jika Anda ingin data Anda tidak terbuka untuk publik dapat memilih layanan 
berbayar. 
 

44.. Klik "Create project in workspace" untuk membuka worksheet. 

 
Gambar 10 Halaman new project pada website KUMU (2) 

 

55.. Pada halaman "pick a template", geser kursor ke bawah dan pilih stakeholder 
templat dengan klik "USE THIS TEMPLATE" untuk menuju worksheet KUMU. 
Silakan lihat di dalam Kotak Tips 4 untuk fitur-fitur dalam worksheet KUMU. 

 

 
Gambar 11 Halaman pemilihan templat untuk new project pada KUMU 
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KKoottaakk  TTiippss  44::  FFiittuurr  ddaallaamm  wwoorrkksshheeeett  KKUUMMUU  

 

AAdddd  bbuuttttoonn: untuk menambah data ke peta (element, connection, loop, sketch, import). 

 

MMeennuu  ppaaddaa  ppoojjookk  kkiirrii  aattaass::  menampilkan  pengaturan utama. 
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33.. Jika Anda memilih untuk layanan tanpa biaya, data Anda dapat diakses publik. 
Jika Anda ingin data Anda tidak terbuka untuk publik dapat memilih layanan 
berbayar. 
 

44.. Klik "Create project in workspace" untuk membuka worksheet. 

 
Gambar 10 Halaman new project pada website KUMU (2) 

 

55.. Pada halaman "pick a template", geser kursor ke bawah dan pilih stakeholder 
templat dengan klik "USE THIS TEMPLATE" untuk menuju worksheet KUMU. 
Silakan lihat di dalam Kotak Tips 4 untuk fitur-fitur dalam worksheet KUMU. 

 

 
Gambar 11 Halaman pemilihan templat untuk new project pada KUMU 
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KKoottaakk  TTiippss  44::  FFiittuurr  ddaallaamm  wwoorrkksshheeeett  KKUUMMUU  

 

AAdddd  bbuuttttoonn: untuk menambah data ke peta (element, connection, loop, sketch, import). 

 

MMeennuu  ppaaddaa  ppoojjookk  kkiirrii  aattaass::  menampilkan  pengaturan utama. 
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  PPeennggaattuurraann  ppeettaa  ddaann  ttaammppiillaann  ppeettaa  ppaaddaa  ppoojjookk  kkiirrii  aattaass::  untuk memilih peta dan preset pengaturan 
visualisasi peta yang akan ditampilkan, juga untuk membuat peta atau preset baru dalam worksheet 
yang sama. 

 

MMeennuu  ppaaddaa  ssiiddeebbaarr: Pilihan cepat untuk menuju pengaturan peta. 

 

 MMeennuu  ddii  tteennggaahh  ffiillee::  Untuk menyembunyikan sidebar sehingga hanya peta yang ditampilkan. 
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. 

MMeennuu  ppaaddaa  ppeettaa::  untuk menampilkan menu pengaturan visualisasi peta. 

 

MMeennuu  wwiizzaarrdd::  berfungsi sebagai menu help, menampilkan berbagai panduan dan jawaban untuk FAQs. 

 

MMeennuu  sseettttiinnggss  ppaaddaa  ppoojjookk  kkiirrii  bbaawwaahh::  menampilkan  pengaturan umum. 
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  PPeennggaattuurraann  ppeettaa  ddaann  ttaammppiillaann  ppeettaa  ppaaddaa  ppoojjookk  kkiirrii  aattaass::  untuk memilih peta dan preset pengaturan 
visualisasi peta yang akan ditampilkan, juga untuk membuat peta atau preset baru dalam worksheet 
yang sama. 

 

MMeennuu  ppaaddaa  ssiiddeebbaarr: Pilihan cepat untuk menuju pengaturan peta. 

 

 MMeennuu  ddii  tteennggaahh  ffiillee::  Untuk menyembunyikan sidebar sehingga hanya peta yang ditampilkan. 
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. 

MMeennuu  ppaaddaa  ppeettaa::  untuk menampilkan menu pengaturan visualisasi peta. 

 

MMeennuu  wwiizzaarrdd::  berfungsi sebagai menu help, menampilkan berbagai panduan dan jawaban untuk FAQs. 

 

MMeennuu  sseettttiinnggss  ppaaddaa  ppoojjookk  kkiirrii  bbaawwaahh::  menampilkan  pengaturan umum. 
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MMeennuu  BBlloocckkss::  untuk menampilkan menu Social Network Analysis dan Community Detection. 

 

MMeennuu  TTaabblleess::  untuk menampilkan data dalam bentuk tabel/matriks. 

  

MMeennuu  MMoorree: Menampilkan menu untuk export atau import data, tampilan fullscreen dan preview. 
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66.. IImmppoorr  ddaattaa  ddaarrii  ddookkuummeenn  EExxcceell  kkee  KKUUMMUU  ddaann  sseettttiinngg  vviissuuaalliissaassii  
ddaassaarr  
1. Impor data dengan cara upload file excel yang telah disiapkan dengan klik "add 

button" lalu "import". 

 
Gambar 12 Import data menggunakan add button 

2. Pada menu import, klik "Choose File", lalu pilih file yang telah disiapkan untuk 
KUMU. Setelah itu pilih import spreadsheet untuk upload file. 

 

Gambar 13 Proses upload file untuk import data ke KUMU 

3. Setelah berhasil dilakukan impor data, KUMU akan otomatis melakukan 
pengecekan error pada data. Jika sudah tidak ada data yang error, import data 
dapat dilanjutkan dengan klik "save import". 
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MMeennuu  BBlloocckkss::  untuk menampilkan menu Social Network Analysis dan Community Detection. 

 

MMeennuu  TTaabblleess::  untuk menampilkan data dalam bentuk tabel/matriks. 

  

MMeennuu  MMoorree: Menampilkan menu untuk export atau import data, tampilan fullscreen dan preview. 
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66.. IImmppoorr  ddaattaa  ddaarrii  ddookkuummeenn  EExxcceell  kkee  KKUUMMUU  ddaann  sseettttiinngg  vviissuuaalliissaassii  
ddaassaarr  
1. Impor data dengan cara upload file excel yang telah disiapkan dengan klik "add 

button" lalu "import". 

 
Gambar 12 Import data menggunakan add button 

2. Pada menu import, klik "Choose File", lalu pilih file yang telah disiapkan untuk 
KUMU. Setelah itu pilih import spreadsheet untuk upload file. 

 

Gambar 13 Proses upload file untuk import data ke KUMU 

3. Setelah berhasil dilakukan impor data, KUMU akan otomatis melakukan 
pengecekan error pada data. Jika sudah tidak ada data yang error, import data 
dapat dilanjutkan dengan klik "save import". 
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Gambar 14 Pengecekan kesalahan pada proses impor data secara otomatis oleh KUMU 

4. Setelah impor data dilakukan, maka KUMU akan otomatis menampilkan peta 
jaringan sosial. Klik menu pada sidebar untuk mengubah nama peta, ubah 
nama peta dan klik "submit". 

 

Gambar 15 Proses penggantian nama peta 

5. Lakukan pengaturan visualisasi peta dengan klik tombol "Settings" → klik 
"color by" dan pilih "element type" → klik expand tanda pilihan pada "color by" 
dan pilih set warna yang diinginkan → ubah "theme" menjadi dark untuk 

 

 
5555  

memberikan kontras yang lebih baik → klik "save" untuk menyimpan 
pengaturan. 

 

 

 

Gambar 16 Proses pengaturan visualisasi peta (1) 
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Gambar 14 Pengecekan kesalahan pada proses impor data secara otomatis oleh KUMU 

4. Setelah impor data dilakukan, maka KUMU akan otomatis menampilkan peta 
jaringan sosial. Klik menu pada sidebar untuk mengubah nama peta, ubah 
nama peta dan klik "submit". 

 

Gambar 15 Proses penggantian nama peta 

5. Lakukan pengaturan visualisasi peta dengan klik tombol "Settings" → klik 
"color by" dan pilih "element type" → klik expand tanda pilihan pada "color by" 
dan pilih set warna yang diinginkan → ubah "theme" menjadi dark untuk 

 

 
5555  

memberikan kontras yang lebih baik → klik "save" untuk menyimpan 
pengaturan. 

 

 

 

Gambar 16 Proses pengaturan visualisasi peta (1) 
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Gambar 17 Proses pengaturan visualisasi peta (2) 

6. Simpan visualisasi peta sebagai tampilan preset default dan ubah nama 
menjadi "Default" dengan cara klik menu di pojok kanan atas pengaturan 
→pilih "rename view" → klik "submit". 

 

 
Gambar 18 Proses penggantian nama preset view 

77.. AAnnaalliissiiss  cceennttrraalliittyy    
1.  Lakukan analisis centrality dengan cara klik tombol "Boxes" pada pojok kanan 

bawah → Social Network Analysis → Geser kursor ke sidebar. 
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Gambar 19 Proses analisis metrik jaringan sosial pada KUMU (1) 

2. Klik "Choose a metric", misalnya Degree → Klik "Discover the connectors/hubs" 
untuk menjalankan perhitungan otomatis → Salin tabel hasil perhitungan 
degree centrality ke dokumen lain. 

 

 
Gambar 20 Proses analisis jaringan sosial pada KUMU (2) 
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Gambar 17 Proses pengaturan visualisasi peta (2) 

6. Simpan visualisasi peta sebagai tampilan preset default dan ubah nama 
menjadi "Default" dengan cara klik menu di pojok kanan atas pengaturan 
→pilih "rename view" → klik "submit". 

 

 
Gambar 18 Proses penggantian nama preset view 

77.. AAnnaalliissiiss  cceennttrraalliittyy    
1.  Lakukan analisis centrality dengan cara klik tombol "Boxes" pada pojok kanan 

bawah → Social Network Analysis → Geser kursor ke sidebar. 
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Gambar 19 Proses analisis metrik jaringan sosial pada KUMU (1) 

2. Klik "Choose a metric", misalnya Degree → Klik "Discover the connectors/hubs" 
untuk menjalankan perhitungan otomatis → Salin tabel hasil perhitungan 
degree centrality ke dokumen lain. 

 

 
Gambar 20 Proses analisis jaringan sosial pada KUMU (2) 
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3. Ulangi langkah 17 dan 18 untuk menghitung metrik lainnya, yaitu closeness 
dan betweenness centrality. 

 
Gambar 21 Pemilihan metrik untuk analisis jaringan sosial pada KUMU 

88.. PPeennggaattuurraann  vviissuuaalliissaassii  hhaassiill  aannaalliissiiss  cceennttrraalliittyy  uunnttuukk  mmeemmbbaannttuu  
iinntteerrpprreettaassii  
1. Setelah ketiga centrality dianalisis, klik "Settings" → klik menu pojok kiri pada 

"Settings" → klik "duplicate view" untuk membuat tampilan yang berbeda 
dengan dasar pengaturan yang sama → ganti penamaannya menjadi “degree 
centrality” → klik "submit". 

 

 
Gambar 22 Proses duplicate view 
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2. Setelah tampilan tersimpan dengan nama yang baru, klik "size by" pada 
pengaturan dan pilih "size by degree". Pilihan ini akan membuat besar ukuran 
elemen pada peta sesuai dengan nilai hasil perhitungan degree centrality → 
klik "save". 
Visualisasi ini membuat ukuran element mewakili nilai degree centrality-nya.  

 
Gambar 23 Proses pengaturan ukuran element 

3.  Klik "zoom fit" untuk mendapatkan proporsi tampilan peta yang sesuai.  

 
Gambar 24 Pengaturan proporsi peta 

4. Untuk menyimpan tampilan peta sebagai file gambar, klik menu "More" pada 
pojok kanan bawah → Pilih "Capture screenshot" → Klik kanan → Klik "Save 
image as". 
Anda bisa menyimpan tampilan peta sebagai file .pdf dengan cara klik menu 
"More" pada pojok kanan bawah → Pilih "Download PDF" 
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2. Setelah tampilan tersimpan dengan nama yang baru, klik "size by" pada 
pengaturan dan pilih "size by degree". Pilihan ini akan membuat besar ukuran 
elemen pada peta sesuai dengan nilai hasil perhitungan degree centrality → 
klik "save". 
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Gambar 23 Proses pengaturan ukuran element 

3.  Klik "zoom fit" untuk mendapatkan proporsi tampilan peta yang sesuai.  

 
Gambar 24 Pengaturan proporsi peta 

4. Untuk menyimpan tampilan peta sebagai file gambar, klik menu "More" pada 
pojok kanan bawah → Pilih "Capture screenshot" → Klik kanan → Klik "Save 
image as". 
Anda bisa menyimpan tampilan peta sebagai file .pdf dengan cara klik menu 
"More" pada pojok kanan bawah → Pilih "Download PDF" 
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Gambar 25 Proses menyimpan peta visualisasi analisis jaringan sosial 

5. Lakukan langkah 20-23 untuk hasil closeness dan betweenness centrality. 

99.. CCoonnttoohh  vviissuuaalliissaassii  ddaann  iinntteerrpprreettaassii  hhaassiill  aannaalliissiiss  jjaarriinnggaann  ssoossiiaall  
mmeenngggguunnaakkaann  KKUUMMUU  

Contoh visualisasi hasil analisis jaringan sosial aktor pada tata kelola komoditas A 
dengan menggunakan KUMU dapat dilihat di bawah ini.  

Gambar 26 Contoh visualisasi hasil analisis 
jaringan sosial dengan KUMU yang menunjukkan 
peta Degree Centrality 
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Gambar 27 Contoh visualisasi hasil analisis 
jaringan sosial dengan KUMU yang 
menunjukkan peta Closeness Centrality 

 

 

 

 

 

 
Gambar 28 Contoh visualisasi hasil analisis 
jaringan sosial dengan KUMU yang 
menunjukkan peta Betweenness Centrality 

 

 

 

 

 

 
Tabel 1 Hasil perhitungan degree, closeness, dan betweenness centrality. 
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Gambar 27 Contoh visualisasi hasil analisis 
jaringan sosial dengan KUMU yang 
menunjukkan peta Closeness Centrality 

 

 

 

 

 

 
Gambar 28 Contoh visualisasi hasil analisis 
jaringan sosial dengan KUMU yang 
menunjukkan peta Betweenness Centrality 

 

 

 

 

 

 
Tabel 1 Hasil perhitungan degree, closeness, dan betweenness centrality. 
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Berdasarkan contoh hasil analisis jaringan sosial dan panduan interpretasi, diidentifikasi 
bahwa perusahaan swasta merupakan aktor yang sangat penting dalam jaringan karena 
berperan sebagai local connector, spreader/senser, dan broker/bottleneck. Secara 
umum, semua aktor memiliki keterhubungan yang baik dalam jaringan, kecuali petani 
dan tengkulak. Semua aktor memiliki kedekatan yang cukup dalam penyebaran 
informasi dalam jaringan. Perusahaan swasta, pemerintah daerah, dan petani adalah 
aktor kunci dalam keberhasilan aliran informasi dalam jaringan. Panduan interpretasi 
nilai degree, closeness, dan betweenness centrality terdapat pada Kotak Tips 5.  

Cara pengaturan visualisasi dan fitur lain di KUMU terdapat pada panduan lengkap 
dari KUMU yang dapat diakses dalam tautan berikut https://docs.kumu.io/. 

KKoottaakk  TTiippss  55::  PPaanndduuaann  iinntteerrpprreettaassii  nniillaaii  ddeeggrreeee,,  cclloosseenneessss,,  ddaann  bbeettwweeeennnneessss  
cceennttrraalliittyy  

MMeettrriikk  IInntteerrpprreettaassii  
DDeeggrreeee  
cceennttrraalliittyy  

Identifikasi local connector/hub. 
Menunjukkan jumlah hubungan yang dimiliki oleh sebuah element. Secara 
umum, element dengan nilai degree yang tinggi memiliki keterhubungan 
yang baik didalam jaringan, namun tidak selalu berarti yang tertinggi di 
jaringan yang lebih luas.   

CClloosseenneessss  
cceennttrraalliittyy  

Identifikasi spreader/senser. 
Menunjukkan jarak sebuah element terhadap element lainnya. 
Menunjukkan kedekatan sebuah element dengan element lainnya dalam 
jaringan. Secara umum, element dengan nilai closeness yang tinggi dapat 
menyebarkan informasi ke dalam jaringan dengan lebih mudah dan memiliki 
kecenderungan yang tinggi untuk dapat mengetahui apa yang terjadi dalam 
jaringan.   

BBeettwweeeennnneessss  
cceennttrraalliittyy  

Identifikasi broker/bottleneck. 
Mengukur berapa kali sebuah element berada di antara hubungan antar dua 
element lainnya. Secara umum, element dengan nilai betweenness yang 
tinggi memiliki kontrol lebih untuk arus informasi dan berperan sebagai 
penghubung kunci dalam jaringan. Nilai betweenness yang tinggi juga 
menunjukkan bahwa element tersebut dapat menjadi titik poin yang 
mendukung kegagalan aliran informasi dalam jaringan. 
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Berdasarkan contoh hasil analisis jaringan sosial dan panduan interpretasi, diidentifikasi 
bahwa perusahaan swasta merupakan aktor yang sangat penting dalam jaringan karena 
berperan sebagai local connector, spreader/senser, dan broker/bottleneck. Secara 
umum, semua aktor memiliki keterhubungan yang baik dalam jaringan, kecuali petani 
dan tengkulak. Semua aktor memiliki kedekatan yang cukup dalam penyebaran 
informasi dalam jaringan. Perusahaan swasta, pemerintah daerah, dan petani adalah 
aktor kunci dalam keberhasilan aliran informasi dalam jaringan. Panduan interpretasi 
nilai degree, closeness, dan betweenness centrality terdapat pada Kotak Tips 5.  

Cara pengaturan visualisasi dan fitur lain di KUMU terdapat pada panduan lengkap 
dari KUMU yang dapat diakses dalam tautan berikut https://docs.kumu.io/. 

KKoottaakk  TTiippss  55::  PPaanndduuaann  iinntteerrpprreettaassii  nniillaaii  ddeeggrreeee,,  cclloosseenneessss,,  ddaann  bbeettwweeeennnneessss  
cceennttrraalliittyy  

MMeettrriikk  IInntteerrpprreettaassii  
DDeeggrreeee  
cceennttrraalliittyy  

Identifikasi local connector/hub. 
Menunjukkan jumlah hubungan yang dimiliki oleh sebuah element. Secara 
umum, element dengan nilai degree yang tinggi memiliki keterhubungan 
yang baik didalam jaringan, namun tidak selalu berarti yang tertinggi di 
jaringan yang lebih luas.   

CClloosseenneessss  
cceennttrraalliittyy  

Identifikasi spreader/senser. 
Menunjukkan jarak sebuah element terhadap element lainnya. 
Menunjukkan kedekatan sebuah element dengan element lainnya dalam 
jaringan. Secara umum, element dengan nilai closeness yang tinggi dapat 
menyebarkan informasi ke dalam jaringan dengan lebih mudah dan memiliki 
kecenderungan yang tinggi untuk dapat mengetahui apa yang terjadi dalam 
jaringan.   

BBeettwweeeennnneessss  
cceennttrraalliittyy  

Identifikasi broker/bottleneck. 
Mengukur berapa kali sebuah element berada di antara hubungan antar dua 
element lainnya. Secara umum, element dengan nilai betweenness yang 
tinggi memiliki kontrol lebih untuk arus informasi dan berperan sebagai 
penghubung kunci dalam jaringan. Nilai betweenness yang tinggi juga 
menunjukkan bahwa element tersebut dapat menjadi titik poin yang 
mendukung kegagalan aliran informasi dalam jaringan. 
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11.. TTuuttoorriiaall  IInnssttaallaassii  UUCCIINNEETT  ddaann  NNeettDDrraaww  
UCINET adalah salah satu 
program untuk mengolah 
data jaringan sosial yang 
dibuat oleh Analytic 
Technologies perusahaan 
software yang berpusat di 
Amerika Serikat. Program ini 
dikembangkan oleh Lin 
Freeman, Martin Everett dan 
Steve Borgatti yang dirilis pertama kali (UCINET versi 4.0) pada tahun 1992. Hingga saat 
ini, versi UCINET yang sudah dikembangkan adalah UCINET versi 6.742. UCINET dapat 
diunduh secara gratis di laman yang disediakan oleh Analytic Technologies di alamat 
https://sites.google.com/site/ucinetsoftware/download. Gambar di bawah ini adalah 
tampilan dari laman tersebut. Laman ini juga menyediakan informasi beberapa tutorial 
penggunaan perangkat lunak ini.  

Pilih versi terbaru dari 
program UCINET yang 
tersedia pada kotak “VVeerrssiioonn  
IInnffoo” di bagian kanan laman 
ini. Klik ddoowwnnllooaadd untuk 
mengunduh program UCINET. 
Setelah itu, akan muncul kotak 
dialog di bawah ini. Klik “ssaavvee  
ffiillee” untuk mengunduh 
dokumen  UCINET. 

Apabila pengunduhan file UCINET telah berhasil, klik dokumen UCINET tersebut untuk 
melakukan instalasi. Pilih kolom “Immediate Installation”. Selanjutnya akan muncul 
kotak dialog baru dan pilih “Yes”.  

 

 
6666  

 

Kotak dialog Setup akan muncul seperti di bawah ini. Silakan baca term and 
condition-nya, apabila Anda menyetujui untuk proses instalasi maka pilih “Yes, I do”. 
Proses instalasi akan berjalan secara otomatis selama beberapa saat. 

 

Apabila proses instalasi berhasil maka akan muncul tampilan di bawah ini, lalu klik 
“Thanks”. 
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tampilan dari laman tersebut. Laman ini juga menyediakan informasi beberapa tutorial 
penggunaan perangkat lunak ini.  

Pilih versi terbaru dari 
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dialog di bawah ini. Klik “ssaavvee  
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dokumen  UCINET. 

Apabila pengunduhan file UCINET telah berhasil, klik dokumen UCINET tersebut untuk 
melakukan instalasi. Pilih kolom “Immediate Installation”. Selanjutnya akan muncul 
kotak dialog baru dan pilih “Yes”.  
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Kotak dialog Setup akan muncul seperti di bawah ini. Silakan baca term and 
condition-nya, apabila Anda menyetujui untuk proses instalasi maka pilih “Yes, I do”. 
Proses instalasi akan berjalan secara otomatis selama beberapa saat. 

 

Apabila proses instalasi berhasil maka akan muncul tampilan di bawah ini, lalu klik 
“Thanks”. 
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Untuk mengatur penyimpanan dokumen-dokumen yang dihasilkan dari program 
UCINET pilih “Set Default Folder” pada bagian pojok kanan bawah. Selanjutnya pilih 
folder penyimpanan sesuai dengan keinginan Anda. Hal ini bertujuan untuk 
memudahkan penyimpanan dokumen hasil analisis dari program UCINET dalam satu 
folder.  

 

 

Pengunduhan program UCINET secara gratis ini merupakan versi “trial” tanpa 
nomor registrasi yang dapat berlaku selama 60 hari. Alternatif lain yaitu pengguna bisa 
membeli program ini dengan nomor registrasi. Untuk informasi harga dan format order 
program UCINET, klik bagian “Purchasing” pada sebelah kiri laman. Hal yang perlu 
diketahui adalah tidak ada perbedaan antara UCINET versi “trial”; dan versi pembelian, 
yang membedakan hanya masa kadaluwarsanya saja. Program NetDraw sudah menjadi 
satu kesatuan dengan program UCINET, sehingga tidak membutuhkan instalasi 
tersendiri.  

22.. FFiittuurr  ddaann  ttoooollss  ppaaddaa  wwoorrkksshheeeett  UUCCIINNEETT  ddaann  NNeettddrraaww    
22..11.. WWoorrkksshheeeett  UUCCIINNEETT  

UCINET merupakan salah satu program pengolah data jaringan sosial yang relatif 
mudah untuk digunakan. Apabila Anda sudah berhasil melakukan instalasi program 
UCINET, Anda dapat klik ikon UCINET sehingga memunculkan tampilan di bawah ini.  
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Gambar 1. Tampilan UCINET 

Menu yang paling sering digunakan dalam melakukan analisis data jaringan adalah 
menu “Network” yang didalamnya terdapat berbagai macam analisis untuk jaringan 
utuh maupun jaringan ego. Menu toolbar yang tersedia pada worksheet UCINET 
mempermudah pengguna untuk melakukan pengolahan data. Berikut merupakan 
tampilan toolbar yang digunakan dalam proses input hingga analisis data. 

 
Gambar 2 Toolbar pada UCINET 

 

aa..  EExxiitt: berfungsi untuk keluar dari software UCINET 
bb.. MMaattrriixx  eeddiittoorr: berfungsi untuk input data mengenai atribut yang dimiliki oleh 

masing-masing aktor 
cc.. DDLL  eeddiittoorr: berfungsi untuk input data relasi antar aktor yang diperoleh peneliti. 

Input dapat dilakukan langsung di kotak yang ada di dalam DL editor atau data 
yang ditulis dalam Microsoft Excel di-copy lalu di-paste ke dalam kotak DL Editor. 

dd.. OOppeenn  ddaattaasseettss: berfungsi untuk membuka file yang disimpan dalam format 
datasets 

ee.. NNeettwwoorrkk: berfungsi untuk menampilkan berbagai analisis jaringan sosial 
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Untuk mengatur penyimpanan dokumen-dokumen yang dihasilkan dari program 
UCINET pilih “Set Default Folder” pada bagian pojok kanan bawah. Selanjutnya pilih 
folder penyimpanan sesuai dengan keinginan Anda. Hal ini bertujuan untuk 
memudahkan penyimpanan dokumen hasil analisis dari program UCINET dalam satu 
folder.  

 

 

Pengunduhan program UCINET secara gratis ini merupakan versi “trial” tanpa 
nomor registrasi yang dapat berlaku selama 60 hari. Alternatif lain yaitu pengguna bisa 
membeli program ini dengan nomor registrasi. Untuk informasi harga dan format order 
program UCINET, klik bagian “Purchasing” pada sebelah kiri laman. Hal yang perlu 
diketahui adalah tidak ada perbedaan antara UCINET versi “trial”; dan versi pembelian, 
yang membedakan hanya masa kadaluwarsanya saja. Program NetDraw sudah menjadi 
satu kesatuan dengan program UCINET, sehingga tidak membutuhkan instalasi 
tersendiri.  

22.. FFiittuurr  ddaann  ttoooollss  ppaaddaa  wwoorrkksshheeeett  UUCCIINNEETT  ddaann  NNeettddrraaww    
22..11.. WWoorrkksshheeeett  UUCCIINNEETT  

UCINET merupakan salah satu program pengolah data jaringan sosial yang relatif 
mudah untuk digunakan. Apabila Anda sudah berhasil melakukan instalasi program 
UCINET, Anda dapat klik ikon UCINET sehingga memunculkan tampilan di bawah ini.  
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Gambar 1. Tampilan UCINET 
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Gambar 2 Toolbar pada UCINET 
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ff.. QQuuiicckkssttaarrtt: berfungsi untuk membuka file datasets dan langsung menampilkannya 
dalam bentuk sosiogram 

gg.. NNeettddrraaww: berfungsi untuk menampilkan spreadsheet software Netdraw 

22..22..     WWoorrkksshheeeett  NNeettDDrraaww  

NetDraw merupakan program untuk menampilkan hasil analisis data jaringan 
sosial dalam bentuk sosiogram. Program ini dikembangkan oleh Borgatti yang menyatu 
dengan program UCINET. Anda dapat membuka worksheet NetDraw dengan klik ikon 

 pada program UCINET.  

 
Gambar 3 Tampilan NetDraw 

Menu yang paling sering digunakan dalam penggunaan NetDraw adalah menu File, 
Analysis, dan Properties. Penggunaan menu-menu ini akan dijelaskan pada sub-bab 
berikutnya. Selain itu, NetDraw juga menyediakan toolbar yang memudahkan pengguna 
untuk melakukan modifikasi tampilan sosiogram. Fungsi dari masing-masing ikon pada 
toolbar adalah yaitu: 

 
Gambar 4 Toolbar pada NetDraw 

aa.. OOppeenn  UUCCIINNEETT  nneettwwoorrkk  ddaattaasseett: berfungsi untuk membuka file relasi yang 
disimpan dalam format dataset UCINET. 
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bb.. OOppeenn  UUCCIINNEETT  aattttrriibbuuttee  ddaattaasseett: berfungsi untuk membuka file atribut aktor 
yang disimpan dalam format dataset UCINET. 

cc.. RReessiizzee  ttoo  ffiillll  aarreeaa: berfungsi menyesuaikan ukuran gambar sosiogram dengan 
ukuran halaman Netdraw. 

dd.. MMoovvee  aallll  ppooiinnttss: menyediakan menu untuk merotasi gambar, zoom in-zoom 
out, mengatur posisi gambar terhadap halaman Netdraw, dan mengubah 
tampilan jaringan. 

ee.. ZZoooomm  iinn  ––  ZZoooomm  oouutt: berfungsi untuk memperbesar dan memperkecil 
gambar sosiogram. 

ff.. KKaawwaaii: berfungsi untuk menampilkan berbagai bentuk tampilan gambar. 

33.. IInnppuutt  ddaattaa  rreellaassii  
Penggunaan UCINET ini secara umum dibagi menjadi tiga bagian, yaitu: Entri 

(input) data, analisis data jaringan dan membuat gambar sosiometri menggunakan 
NetDraw. Pada tahap ini data yang diperoleh di-input dalam bentuk numerik (biasanya 
dalam skala pengukuran nominal ataupun ordinal). Pemasukan data bisa dilakukan 
melalui fasilitas yang ada di UCINET atau software lain seperti Microsoft Excel kemudian 
di-copy ke dalam UCINET. File yang dianalisis pada software ini akan tersimpan dengan 
format datasets. Hal yang harus diperhatikan dalam melakukan input data ke dalam 
UCINET adalah format data yang digunakan. Terdapat tiga format yang paling banyak 
dipakai yaitu Full Matrix, Nodelist, dan Edgelist. Selain itu, arah data juga harus 
diperhatikan dalam proses pemasukan data. Arah data yang dimaksud adalah dalam 
suatu relasi ada aktor yang berperan sebagai subjek (aktif) dan aktor yang berperan 
sebagai objek (pasif). 

33..11.. FFuullll  MMaattrriixx  

Format ini dibuat dalam bentuk matriks segi empat di mana aktor-aktor 
ditempatkan di bagian baris dan kolom. Masing-masing aktor dipasangkan satu sama 
lain berdasarkan relasinya. Angka 0 menunjukkan tidak ada relasi, sedangkan angka 1 
menunjukkan adanya relasi. Aktor yang berperan sebagai subjek ditempatkan di bagian 
baris, sedangkan aktor yang berperan sebagai objek ditempatkan di bagian kolom. Data 
relasi dengan format biner ini paling banyak digunakan untuk melakukan berbagai 
analisis jaringan dengan menggunakan UCINET.  
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analisis jaringan dengan menggunakan UCINET.  
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Gambar 5 Tampilan data dalam format Matrix 

 

3.1.1. Nodelist 

Format ini dibuat dengan membuat daftar aktor-aktor (nodes) dan relasinya. 
Nama-nama aktor dan relasinya dengan aktor lain ditulis secara horizontal. Keuntungan 
dengan menggunakan format ini adalah kemungkinan ada aktor yang tertinggal atau 
luput dari pemasukan data yang bisa dihindari, sehingga format ini biasanya digunakan 
jika anggota aktor berjumlah besar. Kelemahan dalam format ini adalah tidak bisa 
menampilkan nilai dari relasi.  

 
Gambar 6 Tampilan data dalam format Nodelist 
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Aktor yang berperan sebagai subjek ditempatkan di kolom pertama sedangkan 
aktor yang berperan sebagai objek ditempatkan di kolom kedua dan seterusnya. Akan 
tetapi, kelemahan dari format ini adalah nilai dari relasi antar aktor tidak dapat 
ditampilkan. 

33..22.. EEddggeelliisstt  

Format ini mirip dengan format nodelist, perbedaannya yaitu nama aktor dan 
relasinya ditulis secara vertikal (satu nama aktor dengan satu relasinya). Keuntungan 
menggunakan format ini adalah kita bisa mendata aktor dalam jumlah besar dan dapat 
menampilkan nilai dari relasi. Aktor yang berperan sebagai subjek ditulis pada kolom 
pertama, sedangkan aktor yang berperan sebagai subjek ditulis pada kolom kedua. 
Format ini hanya akan menuliskan aktor-aktor yang berelasi, sehingga apabila datanya 
berupa skala nominal maka yang ditampilkan hanya angka 1 saja. Angka dengan skala 
ordinal seperti pada Gambar 7 ini menunjukkan kekuatan relasi antar aktor.  
 

 
Gambar 7 Tampilan data dalam format Edgelist 

 

Setelah mengetahui berbagai format data yang dapat digunakan dalam program 
UCINET, kita dapat melakukan proses pemasukan data dengan pilihan format data 
sesuai dengan kebutuhan. Input data menggunakan UCINET dimulai dengan memilih 

ikon DL Editor ( ) pada toolbar, kemudian akan muncul spreadsheet DL Editor seperti 
pada Gambar 8. Proses pemasukan data yang dilakukan dengan meng-copy data dari 
excel dapat dilakukan dengan perintah langsung Ctrl+c pada file excel dan Ctrl+v di DL  
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Gambar 7 Tampilan data dalam format Edgelist 

 

Setelah mengetahui berbagai format data yang dapat digunakan dalam program 
UCINET, kita dapat melakukan proses pemasukan data dengan pilihan format data 
sesuai dengan kebutuhan. Input data menggunakan UCINET dimulai dengan memilih 

ikon DL Editor ( ) pada toolbar, kemudian akan muncul spreadsheet DL Editor seperti 
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editor spreadsheet atau klik Edit dan pilih Paste. Pada kolom data format di bagian 
kanan spreadsheet, pilih format yang sesuai dengan data yang dimasukkan. Apabila data 
yang dimasukkan berupa matrix, maka pada kolom tersebut juga dipilih format matrix. 

 
Gambar 8 Tampilan “DL Editor” untuk pemasukkan data relasi 

 

Setelah semua data dimasukkan, klik ikon  sebagai tanda bahwa pemasukan data 
telah selesai (final). Data yang telah dimasukkan tersebut disimpan dengan cara klik 
“File” dan pilih “Save UCINET Dataset” atau dengan klik ikon . Simpan file pada folder 
yang diinginkan. Untuk memastikan apakah data tersimpan dalam format UCINET dan 
data yang dimasukkan benar, kita dapat mengecek data UCINET dengan memilih open 

Gambar 299 Hasil input data dalam format dataset 
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dataset ( ). Maka data UCINET akan menampilkan data dalam bentuk teks seperti 
Gambar 8 di bawah ini. 

3.2.1. Pemasukkan data atribut aktor 

Perangkat UCINET ini juga dapat digunakan untuk menganalisis relasi antar aktor 
berdasarkan atribut yang aktor miliki, misalnya usia, gender, jabatan, asal daerah, dsb. 
Penulisan atribut dimulai dengan menulis nama aktor pada kolom pertama diikuti 
dengan atribut aktor di kolom berikutnya. Hal yang harus diperhatikan adalah masing-
masing atribut harus diberi kode karena perangkat UCINET hanya dapat mengolah data 

dalam bentuk numeric. Untuk memasukkan atribut aktor klik matrix editor ( ), 
kemudian masukkan data atribut ke dalam kolom yang tersedia. Atribut aktor dapat 
langsung diketik di matrix editor atau di-copy dari Microsoft excel. Apabila data berasal 

dari file excel, klik ikon  dan cari file yang akan dianalisis. Selain itu, dapat dilakukan 
dengan cara copy file yang ada di Excel kemudian pilih Edit → Paste atau langsung 
menggunakan perintah Ctrl+c dan Ctrl+v. Apabila pemasukan data sudah selesai 

dilakukan, klik ikon  untuk menyimpan file. 

 
Gambar 3010 Tampilan “Matrix Editor” untuk input data atribut 
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Gambar 3010 Tampilan “Matrix Editor” untuk input data atribut 
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3.2.2. Transformasi data 

Sejumlah perhitungan analisis jaringan membutuhkan persyaratan data tertentu. 
Misalnya, perhitungan kepadatan jaringan membutuhkan data berupa dikotomi/biner. 
Apabila data yang kita miliki merupakan data ordinal/ranking maka dibutuhkan proses 
perubahan data agar sesuai dengan syarat yang dibutuhkan oleh perhitungan tersebut. 
UCINET menyediakan menu untuk mengubah data valued (ranking) menjadi data biner.  

 
Gambar 11 Tampilan menu untuk transformasi data 

Pilih menu Transform → Dichotomize, lalu akan muncul kotak dialog seperti pada 

Gambar 12.  Selanjutnya, masukkan dataset yang merupakan data valued pada kolom 

“input dataset” dan pilih lokasi penyimpanan pada kolom “output dataset”. 

 
Gambar 12 Kotak dialog pada transformasi data 
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44.. AAnnaalliissiiss  jjaarriinnggaann  uuttuuhh  
Analisis jaringan utuh yang akan dibahas pada modul ini yaitu analisis struktur yang 

berupa kepadatan jaringan, analisis sentralitas yang berkaitan dengan posisi aktor 
terhadap aktor lainnya, dan analisis kelompok yang berupa klik. 

 

44..11..     KKeeppaaddaattaann  jjaarriinnggaann  

Kepadatan jaringan adalah perbandingan antara jumlah ikatan yang ada (aktual) 
dengan jumlah ikatan yang muncul ketika seluruh aktor dalam jaringan berelasi satu 
sama lain (potensial). Hal yang harus diperhatikan dalam analisis ini adalah data yang 
dibutuhkan adalah data biner (data 0 dan 1) yang menunjukkan ada atau tidaknya relasi 
antar aktor. Analisis kepadatan dapat kita lakukan dengan memilih menu Network → 
Whole network & cohesion → Density → Density Overall.  

 
Gambar 13 Tampilan menu untuk analisis kepadatan jaringan 

Setelah itu, muncul kotak dialog seperti pada Gambar 13. Anda dapat memasukkan 
file yang akan dianalisis pada bagian “Network Dataset” dan pilih folder penyimpanan 
hasil analisis pada bagian “Output dataset”.  
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3.2.2. Transformasi data 
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Gambar 13 Tampilan menu untuk analisis kepadatan jaringan 

Setelah itu, muncul kotak dialog seperti pada Gambar 13. Anda dapat memasukkan 
file yang akan dianalisis pada bagian “Network Dataset” dan pilih folder penyimpanan 
hasil analisis pada bagian “Output dataset”.  
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Gambar 3114 Kotak dialog pada analisis kepadatan jaringan 

Gambar 15 merupakan hasil analisis kepadatan jaringan dengan UCINET. Data 
tersebut menunjukkan bahwa kepadatan jaringan secara keseluruhan adalah 0,641 
atau 64,1%. Data ini menunjukkan bahwa kepadatan jaringan ini tidak tinggi. Jaringan 
ini memiliki karakteristik di mana banyak anggota jaringannya/ aktor-aktor di dalamnya 
tidak saling berelasi atau bahkan tidak saling mengenali satu sama lain.  

 

44..22.. KKlliikk  

Klik adalah pengelompokan aktor dalam suatu jaringan di mana seluruh aktor 
dalam kelompok tersebut saling berinteraksi satu sama lain. Untuk mengidentifikasi klik 
yang ada dalam jaringan, kita dapat menggunakan menu Networks → subgroups → 
cliques.  

Gambar 15 Hasil analisis kepadatan jaringan 
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Gambar 3216 Tampilan menu untuk analisis klik 

Tampilan selanjutnya yang muncul adalah kotak dialog di bawah ini. Masukkan file yang 
akan dianalisis pada kolom pemasukkan dataset. Pada kolom kedua, masukkan berapa 
jumlah minimum anggota dalam klik. Apabila kita pilih 3 aktor dalam satu klik, maka 
yang akan ditampilkan adalah klik dengan jumlah anggota minimal 3 aktor. Tahapan 
selanjutnya yaitu pilih folder lokasi penyimpanan untuk masing-masing output. 

 
Gambar 17 Kotak dialog pada analisis klik 

Hasil analisis pada Gambar 18 menunjukkan bahwa terdapat lima klik pada jaringan ini 
yang beranggotakan minimal tiga orang aktor. Satu orang aktor bisa menjadi anggota 
lebih dari satu klik. Melalui analisis ini dapat diidentifikasi bahwa Jana dan Petr_Ne 
adalah aktor yang memiliki relasi kuat dengan berbagai aktor karena menjadi anggota 
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dari seluruh klik yang ada. Aktor ini juga berpotensi untuk menjadi penghubung bagi 
aktor yang berasal dari klik yang berbeda. 

 
Gambar 18 Hasil analisis yang menunjukkan jumlah dan anggota klik dalam jaringan 

 

 

Gambar 19 Hasil analisis klik pada masing-masing aktor 
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44..33.. DDeeggrreeee  cceennttrraalliittyy  

Hasil analisis ini menunjukkan jumlah relasi dari- (out degree) dan ke- (in degree) 
aktor. Aktor dengan degree centrality tertinggi merupakan aktor yang populer 
dalam jaringan sosial karena memiliki banyak relasi dengan aktor lainnya. Untuk 
melakukan analisis degree centrality pada UCINET, kita dapat memilih menu 
Network → Centrality → Degree. 

 
Gambar 20 Tampilan menu untuk analisis degree centrality 

Perintah tersebut akan memunculkan kotak dialog seperti pada Gambar 21. 
Selanjutnya, masukkan file yang akan dianalisis pada kolom “input network” dan 
pilih lokasi penyimpanan output di folder yang diinginkan. 

 
Gambar 21 Kotak dialog pada analisis degree centrality 

Hasil analisis menunjukkan bahwa relasi yang dimiliki oleh Jana dan Petr_Ne 
adalah 12 dengan nilai degree centrality sebesar 1, artinya kedua aktor tersebut 
berelasi dengan seluruh aktor yang ada di dalam jaringan. Jana dan Petr_Ne 
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merupakan aktor sentral dalam jaringan yang berpotensi untuk mempercepat 
penyebaran informasi atau sumber daya kepada aktor lain pada jaringan.  

 
Gambar 22 Hasil analisis degree centrality 

44..44.. BBeettwweeeennnneessss  cceennttrraalliittyy  

Analisis betweenness centrality memperlihatkan posisi seorang aktor sebagai 
perantara dari hubungan aktor satu dengan aktor lain dalam suatu jaringan. Aktor 
yang berperan sebagai perantara ini sangat penting karena aktor tertentu tidak 
dapat terhubung dengan aktor lainnya tanpa adanya aktor perantara. Analisis 
betweenness centrality penting untuk dilakukan karena berkaitan dengan kontrol 
dan manipulasi informasi oleh aktor yang berperan sebagai perantara tersebut. 
Untuk melakukan analisis betweenness centrality pada UCINET, kita dapat memilih 
menu Network→ Centrality → Freeman betweenness → Node betweenness.  

 
Gambar 23 Tampilan menu untuk analisis betweenness centrality 
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Langkah selanjutnya sama dengan analisis sebelumnya, yaitu dengan memilih 
file yang akan dianalisis dan memilih folder penyimpanan. Hasil analisis di 
bawah ini menunjukkan bahwa terdapat tujuh aktor yang berperan sebagai 
perantara, yang mana Jana dan Petr_Ne merupakan aktor yang paling banyak 
berperan sebagai perantara. Jana dan Petr_Ne merupakan aktor sentral yang 
berpotensi untuk mengontrol jaringan dan memanipulasi informasi. Hal ini 
disebabkan karena komunikasi ke aktor dalam jaringan harus melewati kedua 
aktor tersebut. 

 

 
Gambar 24 Hasil analisis betweenness centrality 

44..55.. EEiiggeennvveeccttoorr  cceennttrraalliittyy  

Perhitungan eigenvector menggambarkan seberapa penting orang yang berelasi 
dengan seorang aktor. Seberapa penting ini digambarkan sebagai seberapa 
banyak relasi yang dipunyai oleh orang tersebut. Berbeda dengan degree 
centrality yang menghitung berapa banyak aktor (nodes) yang berelasi dengan 
aktor, eigenvector fokus pada seberapa populer nodes yang berjaringan dengan 
aktor. Untuk melakukan analisis eigenvector centrality pada UCINET, kita dapat 
memilih menu Network → Centrality → Eigenvector centrality. 
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Gambar 25 Tampilan menu untuk analisis eigenvector centrality 

Hasil analisis menunjukkan bahwa Jana dan Petr_Ne memiliki nilai eigenvector 
tertinggi dibandingkan dengan aktor lainnya, artinya aktor tersebut memiliki relasi 
dengan orang yang penting dalam jaringan. Berdasarkan seluruh analisis sentralitas, 
Jana dan Petr_Ne adalah aktor sentral karena memiliki banyak relasi, berelasi dengan 
orang yang penting dalam jaringan, dan aktor tersebut berperan sebagai perantara. 

 
Gambar 26 Hasil analisis eigenvector centrality 
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55.. AAnnaalliissiiss  jjaarriinnggaann  eeggoo  
Analisis jaringan ego fokus pada bagaimana posisi aktor (ego) dengan aktor lainnya 
(alternya). Analisis jaringan ego yang akan dibahas pada modul ini adalah analisis 
broker. 

55..11.. BBrrookkeerr  ((bbrrookkeerraaggee))  

Analisis broker adalah analisis yang dimaksudkan untuk mengidentifikasi aktor ego 
mana yang berperan sebagai perantara (broker) di antara alter dan apa jenis 
perantara yang dimainkan oleh ego tersebut. Untuk melakukan analisis broker, kita 
dapat memilih menu Network → Ego Networks → G&F Brokerage Roles. 

 
Gambar 27 Tampilan menu untuk analisis broker 

 

Pemilihan menu analisis broker menghasilkan kotak dialog seperti pada Gambar 28. 
Pada kolom “network dataset” pilih file yang berisi informasi relasi antar aktor (yang 
digunakan pada analisis-analisis sebelumnya). Pada kolom “attribute” dataset pilih 
file atribut aktor yang tersimpan dalam format dataset UCINET. Pada kolom 
“output” (terdapat tiga kolom), pilih folder yang diinginkan untuk menyimpan hasil 
analisis tersebut. 
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Gambar 28 Kotak dialog pada analisis broker 

 

Gambar 29 merupakan hasil analisis broker menunjukkan bahwa berdasarkan 
atribut masing-masing aktor, jaringan ini terbagi menjadi lima kelompok yang ditandai 
dengan garis putus-putus. Kelompok pertama adalah Jana yang merupakan mantan 
perdana menteri. Kelompok kedua adalah Ivan, Petr_Ne, Marek yang merupakan deputi 
partai. Kelompok ketiga adalah Ondrej, Roman, Jan, Milan, Lubomir yang merupakan 
agen intelejen. Kelompok keempat adalah Petr_Ne yang merupakan kantor 
pemerintahan. Kelompok kelima adalah Ivo, Roman, Tomas sebagai ayah baptis.  

Jana dan Petr_Ne adalah dua aktor yang paling banyak menjadi penghubung di 
antara kedua aktor lainnya. Kedua aktor tersebut berperan sebagai consultant dan 
liason. Peran sebagai consultant yaitu Jana dan Petr_Ne menjadi penghubung diantara 
dua aktor dengan atribut yang sama. Sebagai contoh, Jana menjadi penghubung antara 
Milan dan Lubomir yang sama-sama berasal dari agen intelijen. Peran sebagai liason 
yaitu Jana dan Petr_Ne menjadi penghubung di antara dua aktor dengan atribut yang 
berbeda. Sebagai contoh, Petr_Ne menjadi penghubung antara Ivo yang merupakan 
ayah baptis dengan Marek yang merupakan deputi partai. 
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Gambar 29 Hasil analisis broker 

 

66.. GGaammbbaarr  ssoossiiooggrraamm  mmeenngggguunnaakkaann  NNeettDDrraaww  
Hasil analisis jaringan pada perangkat UCINET dapat ditampilkan dalam bentuk 
sosiogram untuk memperlihatkan relasi antara satu aktor dengan aktor yang lain 
dalam jaringan dengan sangat mudah. Gambar jaringan ini dibuat menggunakan 

program NetDraw yang ada di dalam UCINET. Klik ikon  pada toolbar UCINET 
untuk membuka halaman NetDraw. 

66..11.. GGaammbbaarr  jjaarriinnggaann  uuttuuhh  

Dokumen yang disimpan dalam dataset UCINET dapat dibuka di program Netdraw 
dengan beberapa cara. Pertama, kita dapat memilih menu File → Open → 
Network. Data atribut juga dapat dibuka dengan menu File → Open → Atribut, 
dengan catatan data relasi (network) harus dibuka terlebih dahulu. Data atribut ini 
tidak akan ditampilkan pada lembar kerja NetDraw, akan tetapi digunakan untuk 
mengubah tampilan sosiogram berdasarkan analisis yang menggunakan atribut 
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aktor. Pilihan lain yang lebih mudah untuk membuka file relasi adalah dengan klik 

ikon  atau , sedangkan untuk file atribut dengan klik ikon . 

 
Gambar 30 Tampilan menu untuk membuka dataset relasi dan atribut aktor 

Apabila sosiogram sudah muncul dalam worksheet, sosiogram tersebut dapat 
disimpan dalam beberapa format yaitu Metfile, Bitmap, Jpeg, dan PNG. Langkah untuk 
menyimpan sosiogram dapat kita lakukan dengan memilih menu File → Save Diagram 
As → Jpeg (jika data ingin disimpan dalam format tersebut). 

 
Gambar 31 Tampilan menu untuk menyimpan sosiogram jaringan utuh 

66..22.. GGaammbbaarr  jjaarriinnggaann  eeggoo  

NetDraw juga dapat menampilkan jaringan yang dimiliki oleh aktor tertentu atau 
dengan kata lain menampilkan relasi antara aktor (ego) dengan aktor lainnya 
(alter). Untuk menampilkan jaringan ego, klik ikon “Ego” pada toolbar, selanjutnya 
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akan muncul kotak dialog seperti pada Gambar 30. Dalam kotak dialog tersebut 
muncul nama-nama aktor yang ada di dalam jaringan. Misalnya kita memilih salah 
satu aktor yang ada dalam jaringan yaitu Roman, maka klik kolom pada nama 
Roman. NetDraw hanya akan menampilkan semua relasi dan aktor yang 
berhubungan dengan Roman. Pada sosiogram tersebut terlihat bahwa Roman 
memiliki delapan alter. 

 
Gambar 32 Tampilan jaringan ego pada NetDraw 

66..33.. MMeenngguubbaahh  ttaammppiillaann  lliinneess//eeddggee//lliinnkk  yyaanngg  mmeennggggaammbbaarrkkaann  rreellaassii  

Tampilan garis pada sosiogram yang menunjukkan relasi antar aktor dapat diubah 
untuk kepentingan estetis maupun untuk menonjolkan aspek tertentu dari 
jaringan. Kita dapat mengubah warna, ukuran, gaya, bentuk arah, dan pemberian 
label pada garis. Ukuran dan label biasanya digunakan untuk menunjukkan 
kekuatan relasi antar aktor (tie strength). Misalnya, kita ingin mengubah 
ukuran/ketebalan garis berdasarkan kekuatan relasi antar aktor, maka data yang 
dimasukkan adalah relasi dengan skala ordinal. Untuk mengubah ketebalan garis, 
kita dapat memilih menu Properties → Lines → Size → Tie strength.  NetDraw akan 
menampilkan jaringan dengan ketebalan garis yang berbeda-beda sesuai dengan 
kekuatan relasi pada masing-masing aktor seperti pada Gambar 33. 
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Roman. NetDraw hanya akan menampilkan semua relasi dan aktor yang 
berhubungan dengan Roman. Pada sosiogram tersebut terlihat bahwa Roman 
memiliki delapan alter. 

 
Gambar 32 Tampilan jaringan ego pada NetDraw 

66..33.. MMeenngguubbaahh  ttaammppiillaann  lliinneess//eeddggee//lliinnkk  yyaanngg  mmeennggggaammbbaarrkkaann  rreellaassii  

Tampilan garis pada sosiogram yang menunjukkan relasi antar aktor dapat diubah 
untuk kepentingan estetis maupun untuk menonjolkan aspek tertentu dari 
jaringan. Kita dapat mengubah warna, ukuran, gaya, bentuk arah, dan pemberian 
label pada garis. Ukuran dan label biasanya digunakan untuk menunjukkan 
kekuatan relasi antar aktor (tie strength). Misalnya, kita ingin mengubah 
ukuran/ketebalan garis berdasarkan kekuatan relasi antar aktor, maka data yang 
dimasukkan adalah relasi dengan skala ordinal. Untuk mengubah ketebalan garis, 
kita dapat memilih menu Properties → Lines → Size → Tie strength.  NetDraw akan 
menampilkan jaringan dengan ketebalan garis yang berbeda-beda sesuai dengan 
kekuatan relasi pada masing-masing aktor seperti pada Gambar 33. 
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Gambar 33 Tampilan menu untuk mengubah ketebalan garis berdasarkan kekuatan 

relasi dan hasil sosiogramnya  

66..44.. MMeenngguubbaahh  ttaammppiillaann  nnooddeess  ((aakkttoorr))  

NetDraw juga dapat mengubah nodes sesuai dengan kebutuhan pengguna. 
Misalnya kita ingin aktor yang memiliki degree centrality tertinggi ditunjukkan 
dengan ukuran node yang paling besar dibandingkan dengan aktor yang lainnya. 
Langkah yang harus kita lakukan adalah memilih menu Analysis → centrality 
measures. Perintah tersebut akan menghasilkan kotak dialog seperti pada Gambar 
34. Pada bagian kolom “Set Node Sizes by”, pilih “degree” lalu klik OK.  

 
Gambar 34 Kotak dialog pada pengukuran node centrality 

Analisis tersebut akan menghasilkan ukuran node sesuai dengan nilai degree 
centrality dari masing-masing aktor. Selain ukuran node yang paling besar, node 
pada aktor sentral ini dapat diberi warna berbeda dengan aktor yang lainnya.  
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Langkah yang harus dilakukan adalah klik kanan pada node Jana → Color → pilih  
 
warna yang diinginkan, misalnya warna merah → OK. Hal yang sama dapat 
dilakukan pada node Petr_Ne. Modifikasi yang dilakukan pada nodes berdasarkan 
analisis degree centrality akan menghasilkan tampilan seperti pada Gambar 36. 

 

 
Gambar 35 Tampilan menu untuk memberi warna yang berbeda pada aktor sentral 

 

 
Gambar 36 Sosiogram berdasarkan analisis degree centrality 
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Langkah yang harus dilakukan adalah klik kanan pada node Jana → Color → pilih  
 
warna yang diinginkan, misalnya warna merah → OK. Hal yang sama dapat 
dilakukan pada node Petr_Ne. Modifikasi yang dilakukan pada nodes berdasarkan 
analisis degree centrality akan menghasilkan tampilan seperti pada Gambar 36. 

 

 
Gambar 35 Tampilan menu untuk memberi warna yang berbeda pada aktor sentral 

 

 
Gambar 36 Sosiogram berdasarkan analisis degree centrality 
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